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Abstrakt 

Tato diplomová práce se zaměřuje na problematiku povodní a dává si za hlavní 

cíl sestavit hydrodynamický model na vodním toku Žejdlík ř. km 0,000 - 14,126, který 

je levostranným přítokem Ohře. Práce je rozdělena na literárni rešerši a praktickou 

část. Literární rešerše pojednává o povodních, příčinách jejich vzniku, ochraně před 

nimi nebo o jejich historii ve zkoumaném území. V praktické části pak byla řešena 

fyzicko-geografická charakteristika území za pomoci vytvořených map, byl vytvořen 

hydrodynamický model v programu HEC-RAS, došlo k hydrotechnickému posouzení 

vodního toku a vyhodnocení map záplavových území. 

Klíčová slova: 

HEC-RAS, digitální model terénu, povodně, průtok, příčný profil 



Abstract 

This diploma thesis focuses on the issue of floods and has the main goal 

to compile a hydrodynamic model of the water course Zejdlik of the river kilometer 

0.000 - 14.126, which is a left-handed inflow of the Ohfe river. The work is divided 

into a literary research and a practical part. The text summary deals with floods, their 

causes, protection against them or their history in the researched area. The practical 

part deals with physical-geographic characteristics of the territory, with the help 

of created maps, construstions of mathematical model is the HEC-RAS program, 

assessment of the hydrotechnical state of the river, creation and evaluation of maps 

of floodplains. 

Keywords: 

HEC-RAS, digital terrain model, floods, flow, cross profile 
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A O P K Agentura ochrany přírody a krajiny 

CEVT Centrální evidence vodních toků 

C H M U Český hydrometeorologický úřad 

C U Z K Český úřad zeměměřický a katastrální 

D M T Digitální model terénu 

D M R Digitálního modelu reliéfu 

D M R 5G Digitálního modelu reliéfu České republiky 5. generace 

HEC-RAS Hydrologie engineering center, River analysis systém 

MZP Ministerstvo životního prostředí 

TIN Nepravidelná trojúhelníková síť 

.shp Shapefile 

S-JTSK Systém jednotné trigonometrické sítě katastrální 

SPA Stupně povodňové aktivity 

QGIS Qauntum geographic information systém 

TIN Triangulated Irregular Network 

V U V T.G.M. Výzkumný ústav vodohospodářský T. G. Masaryka 

Z A B A G E D Základní báze geografických dat 

PF Příčný profil 

Qn, N-letý průtok N-letá povodeň jejíž kulminační průtok je v dlouhodobém 

průměru dosažen nebo překročen jedenkrát za N let (N-letý 

průtok) 

Qs Pětiletá povodeň jejíž kulminační průtok je v dlouhodobém 

průměru dosažen nebo překročen jedenkrát za 5 let (pětiletý 

průtok) 
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průtok) 

Q100 Stoletá povodeň jejíž kulminační průtok je v dlouhodobém 

průměru dosažen nebo překročen jedenkrát za 100 let (stoletý 

průtok) 

Q500 Pětisetletá povodeň jejíž kulminační průtok je v dlouhodobém 

průměru dosažen nebo překročen jedenkrát za 500 let 

(pětisetletý průtok) 
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1 Úvod 

Díky zjevným klimatickým změnám se v přírodě mnohem častěji projevují 

hydrologické extrémy, mezi které řadíme sucho a různé druhy povodní. 

Ty v podmínkách České republiky mohou nastat téměř v jakémkoli období a nesou 

s sebou jak riziko vysokých škod na majetku a přírodě, tak i riziko ztráty na životech. 

Bohužel se povodním v mnoha případech nedá zamezit, jedná se totiž o přirozený 

přírodní jev, který tu s námi byl již od nepaměti. Dá se však určitými kroky snižovat 

jejich riziko nebo aspoň dopady těchto hydrologických událostí. 

Jelikož se systém předpovídání povodní neustále vyvíjí a zlepšuje, 

nej nebezpečnější konsekvence povodně, tedy riziko ztráty lidského života nebo 

dokonce životů, se daří snižovat až eliminovat. Nicméně povodně často páchají 

nemalé škody na majetku i na přírodě. Pro zmírnění těchto následků může sloužit 

vymezení záplavového území, vytváření protipovodňových opatření, předpovídání 

počasí, úprava či zkapacitnění koryt atd. 

Na větších vodních tocích se pro zvládání povodní mohou budovat například 

přehradní nádrže, velké ochranné hráze atd. Nicméně na povodích menších rozměrů 

na takovéto zásahy není prostor nebo nejsou finance. Oto více jsou tato území 

odkázána na vymezení záplavových čar a celkových přípravných povodňových 

opatření. Tyto informace pak mohou sloužit jako podklad pro další opatření v území 

nebo pro lepší ochranu obyvatelstva a jejich příbytků. 

Právě přípravnému opatření, vymezení záplavového území, se tato diplomová 

práce věnuje. A to za pomoci využití matematických modelů. Určení inundačního 

území pro jednotlivé N-leté průtoky pomáhá odhalit nebezpečná místa 

za povodňových událostí, přispívá k pochopení chování povodňové vlny a umožňuje 

tak lépe se připravit, případně do jisté míry předejít, rizikům spojených s tímto 

hydrologickým extrémem. 
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2 Cíle práce 

Diplomová práce se soustřeďuje na řešení těchto stěžejních cílů: 

• vytvořit obecnou rešerši literatury zabývající se povodněmi, příčinami 

jejich vzniku, protipovodňovou ochranou a historií povodní 

ve zkoumané oblasti, 

• vymezení zkoumané oblasti a utvoření analýzy fyzicko-geografických 

vlastností za pomoci geografických informačních systémů, 

• vytvoření hydrodynamického modelu vybrané části vodního toku 

Žejdlík a určení záplavového území pro N-leté průtoky, následné 

vyhodnocení výsledků, 

• hydrotechnické posouzení vodního toku se zaměřením se na průtočnost 

skrze objekty. 

Přínosem této práce je poukázat na problematické části v povodí během 

N-letých průtoků, vytvoření prvního hydrodynamického modelu na tomto vodním 

toku a upozornit na objekty, kterým hrozí během povodní nebezpečí kvůli nízké 

průtočné kapacitě těchto staveb. 

12 



3 Povodně 

Mezi hlavní projevy hydrologických extrémů řadíme velký nadbytek vody 

či naopak její nedostatek. Tyto hydrologické extrémy poté vyvolávají povodně, 

v případě velikého nadbytku vody, či sucho, pokud je vody nedostatek. 

Povodně mohou být zapříčiněny různými faktory, především jsou však 

způsobeny meteorologickými činiteli. Mezi takovéto činitele řadíme například 

extrémní srážky, rychlé tání sněhu způsobené zvýšenými teplotami vzduchu, delší 

období sucha, a tím menší schopností retence vody půdou atd. Velkou roli zde však 

hrají i jiné faktory, jako jsou zejména fyzicko-geografické podmínky oblasti zasažené 

povodněmi, kam můžeme zařadit reliéf přírody, sklony svahů, land cover... Značný 

vliv na průběh či vytvoření povodní může mít i člověk a jeho zásahy do přírody, které 

mohou mít kladný i záporný efekt na vytvoření a průběh povodní. Lidským počínáním 

může dojít ke změně vodního toku, jeho narovnávání či dokonce zatrubnění. Svými 

činy může pozměnit vzhled okolní krajiny a pozměnit její land cover apod. Často 

se stává, že různá opatření, která j sou proti povodním vytvářena, musí být navrhována 

jenom kvůli nevhodným zásahům do režimu vodního toku z předešlých let. Gordon 

a kol. (2004) pak souhrnně uvádí, že povodňová událost je ovlivňována klimatickými 

faktory (evapotranspirace, charakteristiky srážek), počátečními podmínkami v povodí 

(kam řadí vláhovou nasycenost půdy, retenční schopnost území, teplota půdy 

a vzduchu, vegetační kryt) a fyzicko-geografickými faktory (charakter hydrografické 

sítě, tvar povodí, sklon a expozice svahů, geologie, pedologie lokality, využití území). 

Brázdil a kol. (2004) pak uvádí, že na vznik povodní může mít do jisté míry 

vliv dopad globálního oteplování. Tento aspekt a míra jeho vlivu je však stále těžký 

na posouzení. Nicméně je známo, že na našem území se mění roční rozložení srážek, 

kdy přibývá suchých dnů a zároveň přibývá dnů s náhlými a rychlými srážky. Na to 

poukazuje Folland a kol. (2002), který říká, že už ve 20. století došlo o k nárůstu 

teploty vzduchu i výskytu srážek. 

Během povodní dochází k relativně velkému zvýšení průtoků během krátké 

časové periody. To může zapříčinit vylití vody ven z koryta, škody na majetku 

a v neposlední řadě i ztráty na životech. Tyto škody nemusí způsobovat pouze 

vybřežená voda, ale například i nečistoty a materiály unášené ve vodě. Vodní zákon 

č. 254/2001 Sb. (vodní zákon), definuje povodeň jako stav, kdy dojde k výraznému 
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zvýšení průtoků vtocích či zvýšení hladiny v povrchových vodách, což má 

za následek vybřežení vody do přilehlého nechráněného území a tím poškození 

komunikací, staveb, zhoršení hygienických podmínek a škody na životním prostředí. 

Tato definice do značné míry připouští, že povodeň jako taková je především 

problémem pro člověka, pokud zvýšené průtoky vody způsobují škody člověku. Na to 

poukazuje i Slavíková (2007), která říká, že potíže nepředstavuje povodeň jako taková, 

ale problém nastává, když se vodě postaví do cesty člověk a jeho majetek. 

Přičemž jev, při kterém dochází k vybřežení vody z koryta během povodně, 

se nazývá inundace. Inundační území pak představuje území, které je během povodně 

zaplavováno. 

3.1 Povodně v České republice a jejich typy 

V České republice byly hydrologické extrémy známy především důsledkem 

poměrně častých povodní. Od prvního osidlování území dnešní České republiky 

se kvůli fyzicko-geografickým faktorům krajiny lidé usazovali především v okolí 

vodních toků. Proto povodně často způsobovaly ztráty na životech i na obydlích. 

I souhrnně ve střední Evropě historicky docházelo a dochází k povodním oproti suchu 

poměrně často, skoro každý rok. Brázdil (2005) říká, že v přírodních podmínkách 

střední Evropy j sou povodně běžným j evem. 

Díky geografické poloze České republiky, která se nachází ve středu Evropy, 

a také kvůli členitosti místnímu reliéfu zde má mnoho řek své prameniště. Proto je též 

Česko známé pod přízviskem „střecha Evropy". To má za důsledek, že na mnoho 

místech naší krajiny horní a střední úseky vodních toků překonávají značně rychle 

nadmořské výšky. Tyto sklony řek jsou jednou z příčin, proč jsou zde povodně tak 

časté. 

Co se týče typů povodní, lze je na území České republiky rozdělit do dvou 

hlavních kategorií, a to na přirozené povodně a zvláštní povodně. Tyto kategorie dále 

dělíme. Danou kategorizaci uvádí například Čamrová et AI. (2006), která uvádí, 

že přirozené povodně jsou způsobeny především dešti a táním sněhu, zatímco zvláštní 

povodně vznikají v důsledku nějaké technické závady či havárie na vodním díle. 

Na přirozené povodně, jak již z jejich názvu vyplývá, nemá nikterak vliv 

člověk a jsou způsobeny přirozenými přírodními faktory a činiteli. Podle toho, jaké 

faktory mají hlavní zásluhu na vzniku povodní, dělíme přirozené povodně na: 

14 



• Povodně způsobené prudkým táním sněhové pokrývky - dochází 

k nim především v jarním období či v zimních měsících v důsledku 

oblev. Přičemž dost často je rychlé tání sněhu podpořeno i srážkovými 

úhrny. Tyto povodně se vyskytují převážně v podhorských oblastech 

a mohou zasáhnout i níže položená místa. 

• Povodně způsobené dlouhotrvajícími dešti - jsou známé také pod 

názvem „letní povodně". Vznikají totiž především v letních měsících, 

po několikadenních intenzivních deštích. Při těchto deštích dochází 

k takovému nasycení půdy vodou, že půda není schopna zadržet další 

úhrny srážek, a proto poté dochází ke vzniku povodní. Tento typ 

povodní postihuje především středně velké a velké toky. 

• Povodně způsobené přívalovými dešti - také někdy známé 

pod názvem bleskové povodně. Jsou důsledkem krátkodobého velice 

intenzivního deště doprovázeného často bouřkami. V důsledku tohoto 

deště není půda schopna infiltrovat vodu ze srážek a vznikají 

tak povodně. Tento typ povodní může způsobovat značné majetkové 

škody. Jak píše CHMTJ (2005), i když zasažená plocha většinou není 

velká, voda proudí velmi rychle, má velkou ničivou sílu a způsobuje 

tak značné škody. 

• Povodně způsobené ucpáním vodního toku - tzv. ledové povodně 

způsobené plujícími krami a zamrzající vodou v korytech. Vyskytují 

se především v zimě či na jaře. Zamrzlá voda a vzniklé kry mají vliv 

na průtočný profil, který je jejich působením zmenšen. Může tedy dojít 

k vylití vody z koryta, doprovázeného unášením ledových ker. 

Camrová et al. (2006) říká, že může docházet k tvoření tzv. ledových 

bariér, pokud se unášené ledové kry hromadí v místech s mělkým dnem 

či v zúženém korytě. 

Zvláštní povodně jsou způsobeny jinými než přírodními činiteli. Do značné 

míry na ně má vliv člověk, jelikož vznikají poruchou nebo havárií vodních děl. Mohou 

být i cíleně vyvolané člověkem, například cílenému rychlému vypuštění vodní nádrže, 

ke kterému dochází ve snaze zamezit vzniku větší katastrofy. Jak uvádí Brázdil a kol. 

(2005), tímto způsobem dochází k nouzovému řešení kritické situace na vodním díle. 

CHMTJ (2005), rozlišuje tři základní typy těchto povodní: 
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• první typ nastává při protržení vodní nádrže, 

• druhý typ vzniká při poruše vodního díla, kdy může dojít k poruše 

či ke ztrátě funkčnosti výpustných nebo bezpečnostních zařízení, 

• třetí typ nastává, při již zmiňovaném nuceném zásahu člověka, kdy je 

nutné vypustit vodní nádrž za účelem zmírnění nebo předejití 

katastrofy, například vypuštěním nádrže zamezit protržení vodního 

díla. 

3.2 Faktory ovlivňující průběh povodní 

V kapitole o typech povodní jsou do značné míry vysvětleny faktory ovlivňují 

vznik povodní. Jelikož jsou jednotlivé typy povodní nazvány podle převládajícího 

faktoru jejich vzniku. Na průběh povodně má bezesporu vliv mnoho proměnných 

a bylo by velice složité popsat všechny činitele a jejich procentuální podíl na průběhu 

povodní. Musíme si i uvědomit, že v různých oblastech mohou mít faktory různě velký 

vliv na povodně. Proto je v následujících odstavcích nastíněno pouze to nej důležitější. 

Podstatný faktor ovlivňující průběh povodně je povodí a jeho charakteristika, 

kam můžeme začlenit geometrické charakteristiky, orografické charakteristiky, 

geologické a půdní poměry. Dále pak vegetační pokryv povodí, říční síť v povodí 

či antropogenní činnost v povodí nebo i vliv změny klimatu. Dalšími důležitými 

faktory jsou pak meteorologické a hydrologické charakteristiky v dané oblasti, které 

patří i do faktorů ovlivňujících vznik povodní a byly již popsány výše. 

Mezi geometrické faktory ovlivňující průběh povodní lze řadit tvar nebo 

velikost povodí. Tyto faktory mají vliv na dobu soustředění vody v povodí a její 

množství. Hrádek (2008) říká, že tvar povodí ovlivňuje dobu, za kterou se soustředí 

odtok z celé plochy povodí v uzávěrovém profilu povodí. Tvar i velikost povodí také 

značně ovlivňují odtokové poměry (viz obrázek č. 1). Z obrázku č. 1 lze vyčíst 

závislost tvaru povodí na hydrogramu. Přičemž hydrogram nám znázorňuje tvar 

povodňové vlny (Kemel 1991). Hydrogram tak stanovuje průběh povodně, aneb jak 

je závislý průtok na času v průběhu povodňové události. Z hydrogramu tak lze vyčíst 

komplexní reakce povodí na vstup neboli transformační funkci, podle níž se mění 

efektivní déšť na povrchový odtok (Kovář, 1990). Povodí 1 a 2 z obrázku č. 1 mají 

menší protáhlost, a tak průtoky v uzávěrovém profilu dosahují větších maxim než 

u posledního povodí z obrázku, který má tvar protáhlý. 

16 



Obrázek 1: Vliv tvaru povodí na odtokové poměry (Kocum 2019) 

Do orografických faktorů ovlivňující průběh povodní řadíme především sklon 

vodního toku v jednotlivých částech nebo převýšení od nej vyššího místa povodí 

po uzáverový profil. Za uzáverový profil bereme místo či bod v povodí, kterým 

protéká veškerá voda z povodí. Při vyšších sklonech je odtok vody z povodí výrazně 

rychlejší než při sklonech mírných. To může způsobovat vyšší průtoková maxima 

a rychlejší dosažení průtokových maxim vuzávěrovém profilu. Voda při vyšších 

rychlostech odtoku tak má výrazně méně času na retenci. To může mít značný vliv 

na povodňová maxima, kdy tyto faktory mohou způsobovat větší a ničivější povodně. 

Půdní poměry mají výrazný vliv na vsak vody do půdy, jelikož půda má 

společně s krajinným pokryvem výrazný podíl na retenci srážkové vody a na 

akumulaci vláhy. Záleží tak na půdním druhu, který určujeme podle textury půdy, tedy 

podle velikosti půdních částic. S texturou půdy je též spojena pórovitost půdy, 

tzv. celkový objem pórů v půdě. Tyto a další vlastnosti nám určují, jak rychle a do jaké 

míry j e půda schopna zadržet vodu. Pokud maj í půdy malou pórovitost, j ej ich retenční 

schopnosti j sou sníženy, a tak způsobují nebezpečnou odtokovou odezvu v povodí. Jak 

uvádí Kravka (2009), množství a intenzitu průsaku vody určují i půdní poměry, 

ze kterých jsou nej důležitější půdní typy a druhy, jejich mocnost, struktura, 

propustnost a vlhkost. Jde tedy o velice složitý a komplexní problém, který podléhá 

mnoha parametrům. Například černozeme jsou poměrně schopné zadržet 

a akumulovat vodu. Jak uvádí Vopravil (2009), jeden hektar hluboké černozeme může 

akumulovat až 3500 m 3 vody. Černozeme však nemusí mít vždy takto dobré vlastnosti 

akumulace. Kučera (2021) říká, že při intenzivním využívání zemědělské půdy může 

docházet k degradačnímu působení vodní i větrné eroze, která ochuzuje půdu 

o organickou hmotu ajemnozrnné částice, poutající a zadržující srážkovou vodu. 

Dalším půdním typem, který má poměrně dobré retenční schopnosti, mohou být 

kupříkladu kambizemě. Wang (2023) uvádí, že kambizemě a černozeme, vzhledem 
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k dobré infiltraci, jsou půdy s malým rizikem během povodní. Naopak fluvizemě 

mohou být během těchto hydrologických extrémů řazeny jako velice rizikové 

(Wang 2023). 

Geologické poměry mohou mít vliv jak na akumulaci vody, průsak vody 

během srážkové události, tak na velikost povodí. Tyto faktory pak také mohou 

do značné míry ovlivňovat průběh povodní. Dle geologických poměrů totiž dělíme 

povodí na orografické a hydrogeologické. Podle Kocuma (2019) je orografické povodí 

vymezeno rozvodnicí, která probíhá přes nejvyšší kóty, mezi nimi ležícími hřebeny 

a sedly v bezprostřední blízkosti sledovaného vodního toku až k jeho uzáverovému 

profilu. U hydrogeologického povodí však nemusí být rozvodnice vždy kolmá 

na vrstevnice, jako to je v případě orografického povodí. Záleží na geologické stavbě 

a vodě, která by teoreticky měla odtékat do daného povodí, může odtékat na druhou 

stranu do úplně jiného povodí (viz obrázek č. 2). Tourková (2004) dělí stupně 

propustnosti horniny do tří skupin: horniny propustné, horniny polopropustné 

a horniny nepropustné. Tento typ hornin má vliv na množství vody, jaké je možné 

za určitý časový interval propustit, a tak působí jak na rychlou odtokovou odezvu, 

tak na pomalou odtokovou odezvu, tzv. základní odtok. 

Obrázek 2: Orografwká vs. Hydrogeologická rozvodnice (Kocum 2019) 

Jak již bylo zmíněno, i vegetační pokryv má také do značné míry vliv na průběh 

povodní, jelikož ovlivňuje rychlost i procentuální množství přímého otoku 

z celkového objemu srážky. Vegetační pokryv má totiž vliv na retenční schopnosti 

a schopnosti zpomalovat povrchový odtok. Gerrits (2010) uvádí, že velikost intercepce 

závisí na charakteru vegetace (listnaté nebo jehličnaté stromy, křoviny, traviny atd.), 

vlastnostech srážek a na podmínkách výparu. Povodí s velkým množstvím 

vegetačního pokryvu, například plochy s lesy či louky, tak kladněji ovlivňují průběh 
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povodňové vlny než povodí s malým vegetačním pokryvem, například pole 

či zastavěné území. 

I říční síť má vliv na povodně. Jde především o hustotu říční sítě a celkové 

uspořádání říční sítě v rámci povodí. Je však důležité si uvědomit, že každé povodí 

je svým způsobem jedinečné. A tak se může stát, že dvě sousedící povodí, která byla 

zasažena povodní, s podobnými přírodními vlastnostmi, lišícími se pouze v hustotě 

nebo uspořádání říční sítě, nakonec mohou mít stejný průběh povodňové vlny. 

Vl iv změny klimatu může mít ovlivnit jak na průběh povodně, tak jejich vznik. 

To, že se klima mění, je nepopiratelně viditelné na meteorologických a hydrologických 

jevech. Vnáší klimatické oblasti jsme svědky častějších přívalových dešťů nebo 

delších období sucha. Všechny tyto okolnosti mají vliv nejenom na vznik povodní, 

ale i na další faktory, které mohou ovlivňovat vznik i průběh povodní. Například delší 

období sucha má vliv na půdní vlastnosti a může tak do značné míry ovlivnit infiltrační 

schopnosti půd, vegetační pokryv v povodí atd. 

Do faktorů ovlivňující průběh povodně nepopiratelně patří i člověk a jeho 

antropogenní činnost, jelikož svými zásahy jsme schopni do určité míry pozměnit 

všechny ostatní výše uvedené faktory. Konvička (2002) se domnívá, že oteplování 

klimatu je způsobeno lidskou činností. Člověk svými aktivitami může do značné míry 

zasahovat do celého koloběhu vody v přírodě, pozměňovat říční koryta i inundační 

území atd. Stavbami v záplavových území nebo výstavbou objektů nacházejících 

se přímo na vodním toku, mohou být významně narušeny či pozměněny odtokové 

poměry během povodní, může docházet k větším rozlivům, zpětnému vzdutí atd. 

Cílek a kol. (2003) pak tvrdí, že se nacházíme v tzv. období povodňových a teplotních 

extrémů, která by měla trvat dalších padesát let, což je do značné míry je to způsobeno 

lidskými zásahy do přírody. 

3.3 Stupně povodňové aktivity (SPA) 

Stupně povodňové aktivity nám určují především míru povodňového 

nebezpečí při právě odehrávajícím se povodňovém stavu. Stupně povodňové aktivity 

(SPA) jsou ve většině případů navázány na směrodatné limity vodních stavů 

v hlásných profilech na tocích, které jsou uvedeny v povodňových plánech (Roub 

2016). MZP (2011) dále uvádí, že kromě směrodatných limitů se berou k úvaze i mezní 
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či kritické hodnoty dalších jevů. Do kterých se řadí například denní srážkové úhrny, 

hladiny vod v nádržích, pohyb ledů na vodním toku atd. 

SP A mají 3 stupně nebezpečí a tyto kategorie jsou posuzovány v centimetrech 

vodního stavu. Pro jednotlivé třídy SPA mohou být rozlišná protipovodňová opatření, 

informovanost občanů atd. První stupeň nastává, zatímco ostatní dva stupně 

se vyhlašují. Kategorie SPA rozlišujeme dle názvů na stav bdělosti, stav pohotovosti 

a stav ohrožení a jsou více popsány níže. 

1. stupeň povodňové aktivity (bdělost) - nastává při riziku přirozené 

povodně, tudíž pokud působí na povodí faktory, které by mohly 

způsobit povodeň. Zaniká pak při pominutí těchto faktorů, a tudíž při 

pominutí nebezpečí vzniku povodně. Během tohoto stupně tak 

nedochází k vybřežení vody z koryta vodního toku, nicméně dochází 

k navýšení průtoků. Jde tak především o upozornění na hrozící 

povodeň, a tak dochází ke zvýšenému hlídkování a kontrole vodního 

toku. Tento stupeň může nastat i dopředu, kdy CHMTJ na základě svých 

předpovědních modelů může vydat výstrahu pro určité oblasti, a tím 

se uvede v činnost první stupeň povodňové aktivity. Již při tomto 

stupni, se dle CHMTJ (2018a) nesmí provádět jakékoli aktivity v korytě 

i jeho blízkého okolí. 

2. stupeň povodňové aktivity (pohotovost) - vyhlašuje se v případě, 

pokud dojde již k vybřežení vody z koryta, avšak rozliv vody není 

velký a povodeň tak nepůsobí větší škody. Při tomto stupni tak bývají 

zaplavovány především okolní luky, pastviny, porosty či okolní 

komunikace. Přirozená povodeň tímto vybřežením přechází 

v samotnou povodeň. Tento stupeň se také vyhlašuje v případě 

překročení mezních hodnot sledovaných jevů a skutečností na vodním 

díle z hlediska jeho bezpečnosti (Zákon č. 254/2001 Sb.). Povodňové 

orgány při tomto stupni zahajují aktivní obranu proti povodni 

dle platného povodňového plánu. Dochází tak k cíleným krokům, které 

mají zmírnit průběh povodně. 

3. stupeň povodňové aktivity (ohrožení) - vyhlašuje se při stavu, kdy 

dochází k zaplavování rozsáhlejších území a k vzniku nebezpečí 

větších škod, či dokonce k ohrožení lidských životů. Nebo také při 

dosažení kritických hodnot sledovaných jevů a skutečností na vodním 
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díle z hlediska jeho bezpečnosti současně se zahájením nouzových 

opatření (Zákon č. 254/2001 Sb.). Společně se zabezpečovacími 

pracemi, platných dle protipovodňových opatření povodňových plánů, 

probíhají na základě současné situace také evakuace obyvatel 

a záchranné práce. 

Obrázek 3: Stupně povodňové aktivity (ČHMÚ 2018b) 

3.4 Povodňové plány 

Povodňovým plánům se rozumí dokumenty, které mají za cíl předejít nebo 

alespoň zmírnit následky povodňové situace pro danou oblast. Tyto dokumenty dle 

Zákona č. 254/2001 Sb. obsahují informace o vývoji povodně, možnosti ovlivnění 

odtokového režimu, organizaci a přípravu zabezpečovacích prací, dále obsahují 

způsob zajištění včasné aktivizace povodňových orgánů, zabezpečení hlásné 

a hlídkové služby a ochrany objektů, přípravy a organizace záchranných prací 

a zajištění povodní narušených základních funkcí v objektech a v území a stanovené 

směrodatné limity stupňů povodňové aktivity. Vypracovávají se pro různě velké 

celky, a to od nemovitostí, po obce, obce s rozšířenou působností, až po kraje či pro 

celou Českou republiku. Ve své struktuře by na sebe měly navazovat. Plány by měly 

být každý rok hodnoceny, popřípadě upravovány a aktualizovány. Weyskrabová 
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(2011) dále uvádí, že by měly být prováděny jednou do roka povodňové prohlídky. 

Ty mají za cíl zjistit, zda se na vodním toku či v jeho okolí nevyskytují poruchy, které 

by mohly být nebezpečné. 

Obsah povodňových plánuje dělen na tři části: 

1. věcná část - řadíme zde informace potřebné k ochraně před 

povodněmi, například objektů nebo územních celků. Dále zde 

nalezneme hloubky hladin velkých vod a samotné limity pro vyhlášení 

SPA, 

2. organizační část - jedná se především o jmenné seznamy a kontaktní 

údaje odpovědných osob, které jsou zodpovědné za ochranu před 

povodněmi. Dále zde lze naleznout jednotlivé úkoly těchto osob během 

povodně, 

3. grafická část - sem se řadí především mapy a plány, které zobrazují 

oblasti záplavových území, záplavová území při různých N-letých 

průtocích, evakuační trasy, místa soustředění obyvatelstva při evakuaci, 

hlásné profily nebo informační místa. 

3.5 Ochrana před povodněmi za pomoci povodňových opatření 

Jedná se o takový souhrn opatření, která mají chránit před nebezpečím povodně 

jak majetek, tak lidské subjekty, životní prostředí atd. Jelikož se ve většině případů 

nedá povodni předejít, tato opatření mají za cíl především snížit škody působené 

povodněmi. Také se poučují již z předchozích povodňových událostí, a snaží se tak 

zmírnit škody pro budoucí hydrologické extrémy. 

Povodňová opatření se podle zákona č. 254/2001 Sb. dělí do tří hlavních 

kategorií: 

1. Přípravná opatření - které pokrývají období před povodněmi. Radí 

se sem vymezení záplavových území a zhotovení povodňových plánů, 

určování směrodatných limitů SPA. Dle zákona č. 254/2011 Sb. sem 

dále patří provádění povodňových prohlídek, příprava predpovední 

a hlásné služby, organizační a technická příprava atd. 

2. Opatření při nebezpečí a během povodně - tato opatření zahrnují 

činnost hlásné a predpovední služby během probíhající povodňové 

události. Patří sem práce jako jsou varování před povodní, evakuace 
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záplavových území, záchranné práce, zabezpečovací práce, řízení 

průtoků a odtoků, zajištění náhradních služeb v postižených oblastí,... 

3. Opatření po povodni - jedná se o opatření, která přichází na řadu 

po odeznění povodně. Zahrnuje práce na obnově škod způsobených 

povodněmi, posouzení povodňových škod, a s tím i spojenými 

evidenčními a dokumentačními pracemi. 

Povodňová opatření lze také dělit na technická a netechnická opatření. Avšak 

Ustav územního rozvoje (2003) rozděluje opatření do tří kategorií, na technická, 

netechnická a přírodě blízká. 

1. Technická opatření - hlavním účelem technických opatření je zamezit 

nebo zmírnit povodňovou vlnu a držet j i tak dále od lidí. 

Do technických opatření řadíme ochranné hráze, poldry, regulace 

lesního hospodářství a zemědělské aktivity v oblasti, stabilizace koryt 

či zkapacitnění koryt, úprava příčného i podélného profilu vodního 

toku atd. Dávají si za cíl jak změnit chování povodí během povodně, 

tak ochranu povodí během povodňové situace. 

2. Netechnická opatření - na rozdíl od technických opatření, není 

účelem držet povodeň od lidí, ale naopak docílit toho, aby byli lidé dál 

od povodně. Dosahují toho vymezováním záplavových území, 

informováním široké veřejnosti, zdokonalováním systémů zabývajících 

se prognózami povodní atd. 

3. Přírodě blízká opatření - zde jsou myšlena opatření jak na vodním 

toku, tak v celé ploše povodí. Jde o změny využívání pozemků, 

rostlinného pokryvu, zatravňování a zalesňování břehů a přirozených 

inundací, tvorba protierozních mezí a vegetačních pásů prováděné 

k zachycení vody v povodí a zpomalení jejího odtoku (MZP 2000). 

Mají za cíl najít rozumnou rovnováhu mezi hospodařením a urbanizací 

a vytvářet přírodě blízká opatření, která nenarušují přirozený ráz 

krajiny. 

3.6 Záplavová území 

Záplavové území je oblast, která může být při povodni ohrožena rozlivem 

vody. Podle zákona č. 254/2001 Sb., se jedná o území administrativně určená, která 
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mohou být při výskytu přirozené povodně zaplavena vodou. Vlastník vodního toku 

si nechává zpracovat návrh záplavového území, který následně postupuje 

vodoprávnímu úřadu, jenž determinuje aktivní zónu záplavového území. Návrh 

záplavového území a aktivní zóny záplavového území se zpracovává dle vyhlášky 

MZP č. 236/2002 Sb., o způsobu a rozsahu zpracování návrhu a stanovování 

záplavových území (vodní zákon). Přičemž aktivní zóna záplavového území 

se navrhuje dle nebezpečnosti průtoků během povodně. 

V záplavovém území je nepřípustná výstavba škol, nemocnic, zdravotních 

a sociálních zařízení, čerpacích stanic, zřizování skládek komunálních odpadů a látek 

škodlivých vodám, stavby pro chov hospodářských zvířat a pozemků volně 

odplavitelných materiálů (Jílková, Roch a kol., 2006). Dále pak není možné pojistit 

objekty nacházející se v záplavovém území, nebo jsou ceny za pojištění 

mnohonásobně vyšší oproti pojištění objektů, které se nenachází v záplavové oblasti. 

Pro správné určení záplavového území by neměly chybět tyto podklady: 

hydrologické údaje od Českého hydrometeorologického úřadu, digitální model terénu 

nebo digitální model reliéfu, podrobné geodetické zaměření koryta a objektů 

na vodním toku, historické záznamy o povodních, drsnostní koeficient, a nezbytný 

je taktéž terénní průzkum povodí a vodního toku. 

3.7 Historie povodní 

V rámci 21. století bylo zkoumaná povodí zasažena povodňovými událostmi 

několikrát. Nicméně Daňhelka a kol. (2014) uvádějí od roku 2000 tři velké povodně. 

Za první velkou povodeň lze brát tu z roku 2002. V tomto roce byla zasažena povodí 

Vltavy, Labe, Dyje i Ohře. Příčinou povodně byl průchod dvou tlakových níží s teplým 

a vlhkým vzduchem ze Středomoří do střední Evropy, kdy byly nejvíce zasaženy 

oblasti povodí Labe a Vltavy (Duchan et al. 2019). VÚV T.G.M. (2003) říká, 

že povodeň byla způsobena třídenními dešti a postihla především větší toky, 

ale projevila se i na malých povodích. Povodeň lze rozdělit do dvou fází, přičemž první 

započala 7. srpna a druhá 12. srpna. Na obrázku č. 4 pak je viditelné srážkové 

rozložení dešťů, které způsobily tuto povodeň. Jak si lze povšimnout, na naši 

zkoumanou oblast od 6. do 15. srpna dopadlo 100-200 mm. 
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CHMIÚ 2002 

Obrázek 4: Mapa úhrnů srážek za období od 6. do 15. srpna 2002 (ČHMU 2002) 

V roce 2006 zasáhla Českou republiku další povodeň značného rozsahu. Byla 

způsobena dvěma faktory, a to táním sněhu, které bylo způsobeno rychlým jarním 

oteplením, a vydatnými dešťovými úhrny (Daňhelka a kol. 2012). Nejvíce škod bylo 

napácháno v povodích Labe, Moravy a Lužnice, ale i ve zkoumaném povodí Ohře. 

Na majetku v péči s.p. Povodí Ohře vznikly škody, dle zjišťovacích protokolů, 

dosahující až 110 mil. Kč (Povodí Ohře, 2006). Přestože na některých místech 

dosahovala povodeň stejné intenzity jako v roce 2002, nezpůsobila tak veliké škody 

na majetku. A to z důvodů zlepšení protipovodňových opatření. Velmi pozitivně 

se uplatnila opatření ke zvýšení protipovodňové ochrany realizovaná na tocích, 

objektech a zařízeních Povodí Ohře po ničivé povodni z roku 2002 s využitím nejen 

vlastních finančních zdrojů podniku, ale v podstatné míře také zdrojů z dotačních 

programů zajištěných státem i z fondů E U (Povodí Ohře 2006). ČHMU (2006) tvrdí, 

že vlivem Nechranické nádrži na Ohři došlo ke zmenšení kulminačního průtoku 

povodňové vlny. Díky této vodní nádrži tak docházelo i k menším rozlivům Ohře 

na dolním toku Žejdlíku. 

Povodeň v roce 2013 byla nej větší povodní od roku 2002. Tato povodeň měla 

3 vlny. 1. vlna působila v období od 29. května do 5. června, 2. vlna od 10. do 12. 

června a 3. vlna od 24. do 27. června (Povodí Ohře 2013). Ve všech třech epizodách 

byla povodeň způsobena vydatnými úhrny srážek. Přičemž 1. vlna dosahovala 

nejvyšších kulminačních průtoků a 3. vlna měla již kulminační průtoky nejnižší. 

ČHMU (2014) udává, že byly zaznamenávány jak teplotní extrémy, tak na četných 

místech vydatné srážky působící sněhové kalamity a na jaře a začátkem léta i povodně. 
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Povodeň tak byla způsobena mnoha meteorologickými anomáliemi, avšak hlavním 

faktorem byla bezesporu srážková činnost (viz obrázek č. 5). Na území celé ČR byl 

naměřen průměrný měsíční úhrn srážek 113 mm (ČHMU 2014). Dalším významným 

faktorem síly povodně byla nasycenost půd. Kvůli častým srážkovým úhrnům před 

povodněmi již byla půda i vegetace do značné míry nasycena vodou, a tak během 

povodně byla jejich infiltrační schopnost velice omezena (viz obrázek č. 6). 

Na veškerém území povodí vodního toku Žejdlík byl vyhlášen třetí stupeň povodňové 

aktivity. 

Obrázek 5: Úhrn srážek od 29. 5. do 3. 6. 2013 na území ČR (ČHMÚ 2014) 
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Obrázek 6: Ukazatel nasyceni k 1. 6. 2013 (ČHMU 2014) 
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4 Matematické modely 

Matematické modely se snaží zjednodušeně pomocí matematických zákonů 

a rovnic popsat určitý reálný jev. Podle Dooge (1987) nám modely zjednodušeně 

reprezentují části přírodního nebo člověkem formovaného světa, která může 

reprodukovat některé z jeho charakteristik. Modely nám tak zjednodušeně reprezentují 

realitu v digitálním prostředí. 

Ve vodním hospodářství se používají matematické modely, které popisují 

hydrologické jevy. Rodhe (2012) tvrdí, že hydrologický model je zjednodušení 

reálného hydrologického procesu (povrchové nebo podzemní vody), které pomáhají 

pochopit a předpovídat koloběh vody v přírodě. Důležité je si uvědomit, 

že zjednodušováním reality v modelech nastává riziko, a to že simulované jevy již 

nemusí plně korespondovat s realitou. Čím více se tak člověk snaží v modelu 

zjednodušit realitu, tím více se model může lišit od přirozených jevů v přírodě. 

V našem případě vytvořený model například naprosto opomíjí faktor infiltrace. 

Tyto modely tak lze zařadit mezi nástroje, které usnadňují porozumění pro 

vybrané hydrologické procesy. V našem případě jsou využívány právě pro popsání 

povodní. Snaží se tak určitým způsobem popsat hydrologický systém a jeho proměnné. 

Přičemž hydrologický systém lze definovat jako schéma, které dává do vztahu vstup 

s výstupem (Dooge 2003). V situaci, která je popisována touto diplomovou prací, 

je vstupem myšlena voda, jež přitéká do povodí ať už z přítoků, tak z dešťových srážek 

či z tání ledu atd. Výstupem je pak voda, která opouští povodí. Společně tak vstup 

s výstupem ovlivňují změnu zásoby vody v povodí. Tyto modely tak často pracují 

se zákonem zachování hmoty. Kuráž (2017) popisuje tento zákon jako fundamentální 

fyzikální zákon, který posléze umožnil odvození řídících rovnic pro řadu aplikací jako 

pohyb vody, tepla, látek - mísitelných a nemísitelných. 

Tvorba těchto modelů má několik fází. Nejprve je potřeba vybrat správný 

model, jelikož je těchto modelů poměrně dost. Každý model má totiž určité kladné 

i záporné stránky. 

4.1 Základní klasifikace matematických modelů 

Jak už bylo popsáno výše, matematické modely jsou použily pro reprezentaci 

zjednodušené reality. Konkrétnejšou v této práci použily pro stanovení záplavových 
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území a hydrodynamického posouzení vodního toku. Becker a Serban (1990) 

poukazují na to, že modely lze klasifikovat dle různých aspektů do mnoha kategorií. 

Klasifikace modelů se u různých autorů liší, avšak všechna rozdělení vychází 

z všeobecně přijímaného schématu. Například Becker a Serban (1990) rozdělují 

matematické modely do tří skupin: 

• Stochastické modely - v těchto modelech chybí vazba mezi příčinou 

a důsledkem. Zároveň jsou časově nezávislé. Snaha je zde pouze 

o pochopení závislosti mezi vstupními a výstupními daty. 

• Deterministické modely - je zde časová závislost, zároveň j sou zde vztahy 

mezi vstupem a výstupem popisovány dle fyzikálních zákonitostí. 

• Smíšené modely - jde o kombinaci výše zmíněných modelů. 

Valenta (2005) pak dělí modely, které se zabývají hydrologickými procesy, 

do dvou základních skupin: 

• Srážko-odtokové modely (S-0 modely) - využívají se pro modelování 

transformace srážky na povrchový odtok. Jako vstupní parametr tudíž 

slouží srážka, která j e transformována na povrchový odtok. S-0 modelů 

je celá řada, jsou děleny dle různých kritérií do mnoha kategorií (viz 

obrázek č. 7). Existují tak jak stochastické, tak deterministické S-0 

modely. 

• Hydrodynamické modely (HD modely) - na rozdíl od srážko-

odtokových modelů, používají jako vstupní parametr určité množství 

vody proudící korytem vodního toku. HD modely podle Unucka (2010) 

využívají k modelování transformací vody v hydrologických objektech, 

jako jsou koryta vodních toků či vodní nádrže a následným rozlivem 

vody z koryt při vysokých vodních stavech v době povodní. Přičemž 

hydrodynamické modely vycházejí z matematických rovnic 

(algebraických, diferenciálních, integrálních) a ze schematizace 

reálného prostředí (Novák a kol. 2015). V této práci bylo pro modelaci 

hydrologických jevů využito HD modelů. I hydrodynamické modely 

se dále kategorizují dle různých parametrů. Například Bízek a kol. 

(2011) rozdělují hydrodynamické modely až do osmi kategorií. 

Základní rozdělení viz obrázek č. 7. 
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Obrázek 7: Rozdělení S-0 a H-D modelu (Becker a Serban 1990) 

Existuje mnoho programu, které se zabývají modelací povodní. Často tyto 

programy umí modelovat různé scénáře (viz obrázek č. 7). Jedním z nej využívanějších 

matematických modelů v hydrologii je program HEC-RAS. Ten umožňuje jak 

simulaci ustáleného proudění, tak simulaci neustáleného proudění. Jedná se o různé 

typy proudění s volnou hladinou v otevřeném korytě. 

Ustálené proudění je počítáno na základě Bernoulliho rovnice (HEC-RAS 

2019). Tato rovnice pracuje na základě rovnice zákonu zachování hmoty. Proudění 

předpokládá konstantní rychlost průtoků v čase a pouze malé změny hloubek. 

Na rozdíl od ustáleného proudění, neustálené proudění tyto charakteristiky nemusí mít 

konstantní, a tak můžou výsledky z neustáleného proudění více korelovat s realitou. 

U neustáleného proudění se využívá rovnic hybnosti a spojitosti, přičemž zde dochází 

ke změnám rychlostí a hloubek v čase (Barnard et al. 2007). 

V programu lze také využívat modely jiných dimenzí, a to ID modely a 2D 

modely. ID modely neboli jednorozměrné modely jsou mnohem jednodušší 

na náročnost výpočtů i vstupních dat. ID model pracuje především s daty o terénu, 

která získává ze zaměřených příčných profilů. 2D model pracuje s celkovou oblastí 

a k výpočtu využívá digitální model terénu. Výpočty v programu j sou tak delší 

i náročnější, ovšem mnohem více odpovídají realitě. Reidinger a Levitus (2013) tak 

tvrdí, že jsou vhodné pro modelování v širokých, nepravidelných inundačních území. 
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V této diplomové práci se zabýváme jak hydrodynamickým modelováním 

ustáleného proudění v otevřeném korytě, a to na ID modelu, tak modelováním 

neustáleného proudění na 2D modelu, přesněji řečeno v kombinaci 1D/2D. 
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5 Použité programy 

5.1 QGIS 

QGIS neboli Quantum GIS je open source geographic information systém, 

též nazývaný otevřený nebo svobodný systém, je tudíž komerční a zdarma dostupný. 

Program se využívá především pro práci s prostorovými/geografickými daty, 

pro reprezentaci dat v podobě datových modelů, analytickým zpracováním geodat 

a následnou vizualizací výsledků především s využitím kartografických map. 

Pro práci byla využita verze softwaru QGIS 3.24 Tisler a jednalo se o desktopovou 

verzi tohoto systému. 

Jeho nesmírnou výhodou je, že se lze dostat k jeho zdrojovému kódování, 

a program tak lze upravovat a vymýšlet jeho různá zlepšení. Proto je možno 

pro program napsat různé skripty pro potřebné analýzy. Lze též instalovat dostupné 

pluginy, které přidávají další užitečné funkce do aplikace QGIS. Některé tyto pluginy 

byly využity pro diplomovou práci. 

Primárně byl program využit pro vytvoření digitálního modelu terénu, práci 

se zaměřenými body a pro fyzicko-geografickou analýzu oblasti. 

5.2 HEC-RAS 

HEC-RAS je počítačový program, celým jménem známý jako Hydrologie 

engineering center, River analysis systém. Díky němu lze modelovat hydrauliku 

proudění vody a provádět analýzu říčních systémů. Jak píše Ackerman (2012), 

nej častější uplatnění nalezne HEC-RAS při tvorbě záplavových map. Software 

je vyvíjen společností Hydrologie Engineering Center US Army Corps of Engineers, 

která je vlastněna americkou armádou, a je volně dostupný na stránkách této 

společnosti. 

Dlouhou dobu bylo v programu možné vytvářet pouze ID modely, nicméně od 

roku 2015 již umožňuje i 2D modelování. Model HEC-RAS umožňuje simulace 

ustáleného proudění, simulace neustáleného proudění, transport sedimentu a analýzu 

kvality vody (Brunner 2010; HEC-RAS 2022). Významné jsou jeho možnosti výpočtu 

objektů na toku, příčných i podélných staveb. Pro práci byla využita verze softwaru 

HEC-RAS 5.3.1. 
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5.3 Excel 

Jedná se i tabulkový program vytvořený společností Microsoft. Tento program 

posloužil pro vytváření přehledných tabulek, ale i pro interpolaci hydrologických dat. 
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6 Fyzicko-geografická charakteristika území 

Na začátku je důležité vymezit zájmovou oblast, uvést základní informace 

o zkoumaném vodním toku a j eho povodí, dále pak uvést základní fyzicko-geografické 

charakteristiky území atd. To všechno pro pochopení jevů a jejich vzájemných 

souvislostí, co se týče vodního toku Žejdlík a jeho možného chování během povodní. 

6.1 Vymezení zájmového území 

Žejdlík je vodním tokem nacházejícím se v Ústeckém kraji rozprostírajícím 

se ve dvou okresech. Směr vodního toku je směrem od severu k jihu. Svým horním 

a středním úsek zasahuje do okresu Litoměřice, zatímco dolní částí toku zasahuje 

do okresu Louny. Celkem vodní tok zasahuje do devíti katastrálních území, jsou jimi 

Lukohořany, Dřemčice, Koštice, Voj nice u Koštic, Voj nicky, Želevice, Solany, Staré 

a Třebívlice. Jedná se o levostranný přítoke Ohře, do které ústí těsně pod obcí Koštice. 

Z velké části povodí Žejdlíku zasahuje svou severní částí do Chráněné krajinné oblasti 

České středohoří. Nej větším přítokem je Suchý potok, který je pravobřežním přítokem 

Žejdlíku. Lokalita vodního toku a vyobrazení jeho nej významnějších přítoků 

viz obrázek č. 8. 

Ř E Š E N Ý Ú S E K V O D N Í H O TOKU Ž E J D L Í K 

vodní toky v povodí 

povodí vodního toku Žejdlík 
LINHART TCrrtíí, Praha ÍDií. 

1 - 1 | 
["WI. 13,01,2023]- Postupné iltittD:MHI/.*SMJta 

www ID 2Q2P. záktodrtíje*) M™řů»r£h a oMamî h [online], 
Md 13 3J.2Q23J. Gontjpně £ https;/ymyw.diba™J.cifindK.plip?ld-2J 

Obrázek 8: Vymezení zájmového území 
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6.2 Hydrologie řešeného úseku a jeho popis 

Jak již bylo zmíněno, tok se nachází v oblasti Českého středohoří a pramení 

severně od obce Dřevce v blízkosti vrcholu hory Ostrý, který dosahuje výšky 

553 mn.m. Celková délka Žejdlíku je 17,110 km (CEVT, 2020). Plocha povodí 

v místě soutoku s Ohří je 46,6 km 2 (DIBAVOD 2022). Avšak řešený úsek se omezuje 

na spodních 14,126 km od ústí vodního toku, dle aktualizované osy toku. Výpočetní 

model tak zasahuje do tří obcí. Patří sem Koštice, Třebívlice a Děčany. 

Řešený úsek Žejdlíku má proměnlivý podélný sklon, který lze rozdělit na tři 

charakteristické úseky. Podélný sklon se ve směru toku snižuje (viz tabulka č. 1). Trasa 

vodního toku je z velké části úseku upravená a napřímená. V okolí vodního toku 

se také nachází řada zaniklých rybníků. 

Tabulka 1: Průměrné podélné sklony koryta 

Úsek toku 

(ř. km) 
Popis úseku 

Průměrný podélný 
sklon úseku (%) 

14,126- 12,279 
začátek úseku - mezi Třebívlicemi 
a Solany 

3,3 

12,279-8,587 
mezi Třebívlicemi a Solany - nad 
rozděl ovacím objektem do Rosovky 

2,2 

8,587-0,000 nad rozděl ovacím objektem do 
Rosovky - ústí do Ohře 1,1 

14,126 - 0,000 začátek úseku - ústí do Ohře 1,4 

Inundační území Žejdlíku je v horním úseku údolí mírně sklonité. Níže po toku 

se inundační území stává plochým. V některých místech, vlivem úpravy koryta a jeho 

trasováním, je inundační území níže položené než břehové hrany. V intravilánu obcí 

je tok z velké části lemován silničními komunikacemi a zástavbou, přičemž samotný 

vodní tok má koryto v intravilánu téměř všude napřímené a upravené. V těchto obcích 

je tok prakticky v celé délce lemován zástavbou, a to převážně obytnou. V extravilánu 

pak protéká převážně mezi poli, dále mezi louky a lesy. Narovnáním toku dochází 

k zvýšení průtokové rychlosti vody během povodně, což může mít ničivé následky 

povodní jak v takto upravených korytech, tak především ve spodnějších částech toku. 
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V řešeném úseku tok neprotéká žádnými vodními nádržemi. Nicméně 

se v přímé blízkosti vodního toku nacházejí dva rybníky u přírodní památky Kuzov, 

dva rybníky a jedno koupaliště v obci Třebívlice a dále pak malá vodní plocha u obce 

Vojničky. Historicky však Žejdlík protékal několika rybníky. Patrné to je z map 

2. vojenského mapování (viz obrázek č. 9). Oproti historii došlo k významným 

změnám na vodním toku i v jeho povodí. 

Obrázek 9: Rybník u obce Solany z 2. vojenského mapovaní (CENIA 2022) 

Na samotném vodním toku se nachází mnoho objektů. Lze zde nalézt 30 mostů, 

vesměs železobetonové a dřevěné konstrukce, 14 lávek, také železobetonových 

či dřevěných, 4 stupně, 1 jez a 1 propustek. Všechny tyto objekty mohou ovlivňovat 

průběh povodní (viz kapitola č. 3.2) a byly tak zahrnuty do modelu. 

Pro výpočetní model nebyla použita oblast celého povodí vodního toku, ale 

pouze okolí koryta, které by mohlo být během povodní zaplaveno (viz obrázek č. 10). 

Model totiž pracuje především s digitálním modelem terénu, zabývá se rozlivy 

z koryta řeky a inundačním územím, a tak širší okolí povodí je pro výpočetní schéma 

modelu méně podstatné. Zároveň platí, že čím menší model, tím rychlejší výpočty. 
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Obrázek 10: Oblast digitálního modelu terénu pro výpočet modelu 

Co se povodní týče, během prohlídky toku nebyly na Žejdlíku zjištěny žádné 

povodňové značky, ani stopy po historických povodních. Pro zajištění archivních 

údajů byly v rámci studie osloveny dotčené obce Koštice, Třebívlice a Děčany, avšak 

žádné obce nedisponovaly dokumentací o povodňových událostech. Samozřejmě zde 

bylo v tomto století mnohem více menších povodní, avšak nedosahovaly takových 

rozměrů jako zmíněné povodně v kapitole č. 3.7. 

6.3 Geologické a půdní poměry 

Co se týče půdních poměrů, nejvíce se v oblasti vyskytují černozeme. V malé 

míře pak fluvizemě a kambizemě eutrofní (viz obrázek č. 11). Do jisté míry dané 

území zasahuje, nebo alespoň hraničí, s Polabskou nížinou. Jde tudíž o velice úrodnou 

oblast, na které se nachází mnoho zemědělských polí. I zmiňované kambizemě j sou 

zde vhodné pro zemědělské obdělávání. Jak uvádí AOPK (2023a), eutrofní 
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kambizemě zde mají vysoký obsah živin a často tvoří kombinace s lesními a jílovitými 

půdami. V zájmovém území se tak nachází jak půdy s velkým, tak půdy s malým 

rizikem během povodní (viz kapitola 3.2). 

Z hlediska hornin se zde nachází především vápnité jílovce a slínovce, a poté 

v malé míře alkalické bazalty (viz obrázek č. 11). Vápnité jílovce a slínovce řadíme 

mezi usazené horniny, přičemž vznikaly usazováním materiálů ve vodním prostředí. 

Tyto horniny jsou důkazem existence pradávného mělkého moře (AOPK 2023b). 

Jedná se otřetihorní vulkanická pohoří nejčastěji tvořena čedičovými (téměř ze tří 

čtvrtin), trachytickými a andezitickými horninami (AOPK 2023b). Proto se alkalické 

bazalty nachází v severní části povodí, v okolí hory Ostrý. 

G E O L O G I C K É A P Ů D N Í P O M Ě R Y 

Půdní typy Geologická mapa hornin 

alkalické bazalty 
vápnité jílovce 
vápnité jílovce a slínovce 

LINHART Tomáä, Praha 2022. 
Zpracováno v programu QGIS 3.23-2 

Zdroja: ČGS, 2017. Geologická mapa 1 : 500 000 [online], 
[vid. 14,01.2023]. Dostupné z: http://http://bitly,ws/yVzd  

CENIA, Í017. Pôdni mapa 1 : 1 000 0O0 [online], 
[vid. 14.01.2023]. Dostupné z: http://bitly.ws/yVzq 

Obrázek 11: Mapa geologických a půdních poměrů 
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6.4 Land cover 

Lambin (2007) definuje land cover jako povrch planety Země (či přilehlé 

povrchy), který zahrnuje biotu, půdy, topografii, povrchovou a podzemní vodu, lidské 

(většinou zastavěné) struktury. Pro modelování chování řeky při hydrologických 

extrémech jako je povodeň, je velice důležité znát land cover zájmové oblasti, jelikož 

se z něj stanovují drsnosti, které se zadávají do modelu. Určujeme je jak pro koryto, 

tak pro celé inundační území. Vypracovanou mapu land cover zájmové oblasti lze najít 

v obrázku č. 12. 

L A N D C O V E R V Z Á J M O V É M U Z E M I 

land cover 
• budovy 

průmyslové areály 
• komunikace včetně chodníků 

parkoviště 
k\N kolejiště 

t ravní porosty 
okrasné zahrady, parky 
ovocné sady 

^1 lesní půda s krov inatým porostem 
^ 1 lesní půda se stromy 
H orná půda 
• vodní plochy 
• bažina 

l iniové prvky 
modelovaný úsek Žejdl íku 
oblast DMT 

1 km A 

LINHART Tomáš, Praha 2022. 
Zpracováno v programu QGJS 3.28.2 

Obrázek 12: Land Cover zájmového území 
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Jelikož se jedná o zemědělsky využívanou půdu, zemědělské plochy 

s ovocnými sady tvoří až 68 % celkové plochy území. Dále pak zde najdeme travní 

porosty s 16 % zastoupení a lesy, které zabírají zhruba 9 % plochy (viz tabulka č. 2). 

Dle land cover lze zjistit i vegetační charakteristiky v území, které nám také 

mohou ovlivňovat chování povodňové vlny. Díky vegetaci může dojít ke snížení 

rychlosti vody, která stéká ze svahů, ale může mít i vliv na intercepci srážky (viz 

kapitola č. 3.2). 

Tabulka 2: Procentuální zastoupení land cover v zájmovém území 

LAND COVER Zastoupení v % 

budovy 1,72% 

komunikace včetně chodníků 1,73 % 

zástavba 0,66 % 

průmyslové areály 0,38 % 

parkoviště 0,01 % 

kolejiště 0,04 % 

travní porosty 16,02 % 

okrasné zahrady, parky 0,46 % 

ovocné sady 7,94 % 

lesní půda s krovinatým porostem 2,04 % 

lesní půda se stromy 7,04 % 

orná půda 59,90 % 

vodní plocha 1,79% 

bažina 0,26 % 

6.5 Klimatické podmínky 

Je velice důležité, z hlediska povodní, znát klimatické podmínky panující 

v oblasti povodí a jeho širšího okolí. A to z mnoha důvodů. Jedním z nich je predikce 

povodní, dále pak určení převažujícího typu povodní. Dle klimatických podmínek 

můžeme zjistit i jistou náchylnost území k vytvoření příležitostných podmínek 

pro tvorbu povodní atd. 

Zájmová oblast byla klimaticky charakterizována dle Quittovy klasifikace 

z roku 1971. Podle Quitta (1971) lze rozdělit povodí Žejdlíku do čtyř klimatických 
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klasifikací. Přičemž tři ze čtyř klimatických oblastí se nachází v horních partiích toku 

a zaujímají malou část povodí, jejich změna je vyvolána především změnou 

v nadmořské výšce reliéfu a díky rozdílným teplotám v těchto oblastech. Jedná se 

o oblasti CH4, MT7 a MT5. Střední a dolní tok Žejdlíku se celý nachází v oblasti T4. 

CH4 patří dle klasifikace do oblasti chladné a vyskytuje se ve vrcholových 

partiích vodního tok. Tuto oblast lze charakterizovat jako velice chladnou, zimy 

tu bývají dlouhé, zatímco léto je krátké a vlhké. Jaro a podzim bývají chladné. Mezi 

podstatné znaky této oblasti patří dlouhodobá přítomnost sněhové pokrývky. 

S klesající nadmořskou výškou prochází oblastmi MT7 a MT5, které patří 

do oblastí mírně teplých, též nazývaných jako oblasti přechodné. Jejich rozloha 

v oblasti D M R je vyšší než u oblasti CH4. Tyto oblasti jsou známé krátkým jarem 

a podzimem, jejich léto a zima bývají suché. 

T4 patří mezi teplé oblasti a rozprostírá se na nej větší části zájmového území. 

Tato kategorie je známá pro krátké jaro, dlouhé a teplé suché léto a krátký teplý 

podzim i zimu. Podrobnější klasifikace klimatických oblastí viz tabulka č. 3. 

Díky poměrně velkým rozdílům v nadmořské výšce a vysokému počtu 

klimatických oblastí na relativně malou zájmovou sféru, tak může docházet 

k rychlému tání ledové a sněhové pokrývky a ke vzniku tzv. povodním způsobených 

prudkým táním sněhové pokrývky (viz kapitola č. 3.1). 

Tabulka 3: Údaje o klimatických oblastech (Ouitt 1971) 

chladné 
oblasti mírně teplé oblasti teplé oblasti 

CH4 MT7 MT5 T4 
Poče t l e tn í ch d n í 0-20 30-40 30-40 60-70 
Poče t d n í š p r ů m . 
teplotou 10 °C a v íce 

80-120 140-160 140-160 170-180 

Poče t d n í š mrazem 160-180 110-130 130-140 100-110 
Poče t l e d o v ý c h d n í 60-70 40-50 40-50 30-40 
P r ů m . l e d n o v á teplota -6 až -7 -2 až -3 -4 až -5 -2 až -3 
P r ů m . č e r v e n c o v á 
teplota 

12-14 16-17 16-17 19-20 

P r ů m ě r n ý p o č e t d n í se 
s r á ž k a m i 1 mm a v íce 

120-140 100-120 100-120 80-90 

Suma srážek celkem 1000-1200 650-750 600-750 500-650 
Poče t d n í se s n ě h o v o u 
p o k r ý v k o u 

140-160 60-80 60-100 40-50 
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7 Metodika 

Prostudována odborná literatura, vypracována literární rešerše a vypracována 

fyzicko-geografická charakteristika zájmového území nám pomohla pochopit základní 

charakteristiky zkoumaného toku, seznámit se s problematikou povodní jak obecně, 

tak ve zkoumané oblasti, a mohlo tak dojít k pochopení základních hydrodynamických 

procesů. Po těchto krocích se mohlo přejít k tvorbě hlavního cíle této diplomové práce, 

čímž je určit záplavové území pro zadanou oblast. 

Nicméně aby došlo k lepšímu seznámení se s oblastí, bylo nutné nejprve 

provést terénní průzkum lokality. Při této příležitosti byla zhotovena fotodokumentace 

objektů na vodním toku. Terénní průzkum i fotodokumentace nám byly nápomocny 

v mnoha dalších krocích i při validaci výsledků. 

Pro správnou kalibraci modelů bylo nutné získat vstupní data a korektně s nimi 

pracovat v modelech určených pro modelaci hydrodynamických procesů. Přičemž čím 

více přesná jsou vstupní data, tím větší je pravděpodobnost korektnosti výsledků. 

Tato metodika byla vypracována v rámci projektu „Zpracování podkladů pro 

stanovení záplavových území a map povodňového ohrožení v územní působnosti 

státního podniku povodí Ohře" ve společnosti Vodohospodářský rozvoj a výstavba 

a.s., podvedením Ing. Filipa Urbana. Veškerá data byla poskytnuta v rámci této studie. 

7.1 Podkladová data 

7.1.1 Výškopisná data 

Výškopisná data slouží pro přesné určení digitální modelu terénu. Pro tento 

účel jsme využili data Digitálního modelu reliéfu České republiky 5. generace 

(DMR 5G). Tato data poskytuje Český úřad zeměměřičský a katastrální (ČUZK) a lze 

je dohledat online na jejich geoportálu, v datové sadě Základní báze geografických dat 

(ZABAGED), ve výškopisné skupině těchto dat. Bodová měření z D M R 5G 

představují nejpřesnější polohové a výškopisné informace, které se týkají celé plochy 

České republiky. Model vznikal metodou leteckého laserového skenování a byl 

dokončen roku 2016. Představuje zobrazení přirozeného nebo lidskou činností 

upraveného zemského povrchu v digitálním tvaru, ve formě výšek diskrétních bodů 

v nepravidelné trojúhelníkové síti (TIN) bodů o souřadnicích X , Y , H (ČUZK, 2016). 

Souřadnice X a Y představují informace o zeměpisné šířce a zeměpisné délce. 

41 



Souřadnice H poté představují informace o nadmořské výšce daného bodu a jsou 

spjaté s referenčním výškovým systémem Baltským po vyrovnání. Dle C U Z K (2016) 

má úplnou střední chybovou výšku v rozmezí do 0,18 m v odkrytém terénu a 0,3 m 

v zalesněném terénu. 

7.1.2 Hydrologická data 

Pro naše účely bylo zapotřebí získat data N-letých průtoků zájmového území, 

a to pro Q5, Q20, Q50, Q100 a Q500. Tyto informace byly poskytnuly Českým 

hydrometeorologickým úřadem v prosinci roku 2020, a to pro N-leté průtoky Qi, Q2, 

Q5, Q10, Q20, Q50, Q100 a Q500, v rámci zmiňované studie „Zpracování podkladů pro 

stanovení záplavových území a map povodňového ohrožení v územní působnosti 

státního podniku povodí Ohře". Přičemž záplavová území se budou vypracovávat, jak 

je uvedeno výše, pro N-leté průtoky Q5, Q20, Q100 a Q500, ostatní N-leté průtoky pro 

lepší verifikaci postupů i výsledků. Umístění těchto profilů viz obrázek č. 13. 

Obrázek 13: Mapa lokalit hydrologických dat 

7.1.3 Hydrotechnická data 

Hydrotechnická data nám reprezentují údaje o zaměřených objektech, 

konkrétně o jejich polohových a výškopisných informacích. Ty byly k dispozici 

z geodetického zaměření toku firmou G E O D E X Tomáš Rossiwal, geodetické práce 
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jsou z března roku 2021 a týkaly se všech objektů nacházejících se na zkoumané části 

vodního toku. Z geodetického zaměření byly též dostupné informace o korytě toku 

a jeho blízkého okolí, obsahují podrobné polohové informace o zaměření dna koryta, 

svahů a břehových hran. 

7.1.4 Podkladové mapy 

Nedílnou součástí pro správné určení polohy vodního toku a celkově pro 

kontrolu vstupních i výstupných dat, byly podkladové mapy. Jednalo se především 

o Základní mapu České republiky v měřítku 1 : 10 000, která patří mezi rastrová 

mapová díla. Dále pak barevné ortofoto snímky České republiky nesoucí název 

Ortofoto České republiky. Obě tato mapová díla byla získána z geoportálu ČUZK 

a bylo pracováno s jejich verzí z roku 2019. 

7.2 Postup zpracování ID modelu 

7.2.1 Tvorba digitálního modelu terénu 

Data D M R 5G, která obsahovala body s nadmořskými výškami, byla 

poskytnuta v rámci kladů v textovém souboru, ty bylo zapotřebí spojit do jednoho. 

Bylo také potřeba si uvědomit, že poskytnuté body jsou v I. kvadrantu, kde jsou 

zeměpisné souřadnice vkladných hodnotách a bylo je tudíž potřeba převést 

do III. kvadrantu, kde jsou hodnoty již záporné. V III. Kvadrantu je také nutné mezi 

sebou vyměnit sloupce s nadmořskou výškou a šířkou. Tyto kroky byly vytvořeny 

v programu Excel, kde bylo přidáno zeměpisným souřadnicím záporné znaménko 

a poté byly pozměněny sloupce X a Y . Poté došlo k propojení kladů do jednoho 

textového souboru s názvem „DMR5G_merge_IIIkv". 

Tento textový soubor byl následně nahrán do programu QGIS prostřednictvím 

záložky Data Source Manager pomocí nástroje Add Delimited Text Layer (viz 

obrázek č. 14). V tomto nástroji se nahraje vytvořený soubor DMR5G_merge_IIIkv 

a určí se Geometry Definition dle souřadnic bodu. Důležité je nezapomenout 

na zadání nadmořské výšky bodu a nastavit správný souřadnicový systém, v našem 

případě se jedná o Systém jednotné trigonometrické sítě katastrální (S-JTSK). 

Výstupem je bodová vrstva ve formátu shapefile (.shp). 
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Obrázek 14: Nastavení nástroje Add Delimited Text Layer v QGIS 

Z této vrstvy se již vytvořil digitálni model terénu, a to ve formátu 

TriangulatedIrregular Network (TIN). Tento krok se provedl pomocí nástroje TIN 

interpolation v programu QGIS (viz obrázek č. 15). V tomto nástroji byl extent 

zaokrouhlen na sudé celé metry, velikost pixelu pro vyšší přesnost byla nastavena 

pouze na 0,25 m. Výstupem je vrstva s názvem DMR5G_0_25m.tif a jedná 

se o nezahloubený model terénu. Jako interpolační metoda byla použita forma výpočtu 

LINEAR. Tento model TIN reprezentuje zemský povrch pomocí nepravidelné 

trojúhelníkové sítě. 
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Obrázek 15: Nástroj TIN Interpolation 

Poté byla vytvořenému TINU určena barevná symbologie, především pro 

přehlednost digitálního modelu terénu. Celá vrstva byla též oříznuta, a to na území 

použité pro následný výpočet modelu (viz obrázek č. 10). Oříznutí bylo provedeno 

pomocí nástroje Extract by Mask, kdy byl zmíněný TIN zmenšen pomocí vektorové 

plošné vrstvy a bylo tak docíleno zredukování velikosti celého souboru. Tím se 

i docílilo výrazně lepší výpočetní rychlosti programu. Též nemělo smysl ponechávat 

ta místa digitálního modelu terénu, kde jsou tak velké rozdíly v nadmořských výškách, 

že zde nemůže dojít k rozlivům při povodních. 

7.2.2 Dopočet hydrologie 

Jak již bylo uvedeno výše, hydrologická data byla získána od C H M U . 

V zájmové oblasti se však nevyskytuje hlásný profil, a tak jsou data od C H M U 

vypočtena dle N-letých průtoků. Tato data řadíme do IV. třídy přesnosti, jejichž 

maximální průtoky jsou odvozené ze srážek. ČSN 75 1400 „Hydrologické údaje 

povrchových vod" (1997) udává, že tato data mohou mít střední kvadratickou chybu 

u velkých průtoků až 50 %. Poskytnuty byly údaje pro dva zájmové body na vodním 

toku, a to pro hydrologický profil nad rozděl ovacím objektem do Rosovky, a pro 

hydrologický profil při ústí toku do Ohře (viz obrázek č. 16 a tabulka č. 4). 
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Tabulka 4: N-leté průtoky On pro hydrologické profily (ČHMÚ 2020) 

Hydrologické profily 
N- le té p r ů t o k y Qn r o z d ě l o v a č i objekt do 

Rosovky 
ús t í do O h ř e 

Q i [m 3 /s] 4,01 6,19 
Ch [m3/s] 6,41 9,89 
Os [m3/s] 10,40 16,10 
Qio [m 3 / s ] 14,20 21,90 
Q20 [m3/s] 18,00 28,70 
Qso [m3/s] 25,20 38,90 
Qioo [m3/s] 31,10 48,00 
Q500 [m3/s] 45,00 70,00 

Pro přesnější analýzy jsme však přidali další čtyři profily v místech větších 

přítoků do zájmového vodního toku. Jedná se o profily s názvem: u Voj nic, 

nad Suchých potokem, mezi Třebívlicemi a Solany a u Kuzova. Přičemž poslední dva 

naše zvolené profily se nachází mezi profily poskytnutými od C H M U a první dva 

se nachází nad hydrologickým profilem rozdělovači objekt do Rosovky (viz 

obrázek č. 16 a tabulka č. 5). 

Dopočet hydrologických profilů byl vytvořen na základě plochy povodí 

a známých N-letých profilů od C H M U . Jelikož naše zájmové území je relativně malé 

a potřebujeme zjistit plochy povodí pouze pro čtyři hydrologické profily, došlo 

v aplikaci QGIS k dopočtení „ručně". A to zjištěním plochy povodí z vrstevnic 

podkladové mapy. Tímto způsobem jsme pomocí Editace rozdělili naše zájmové 

povodí na více dílčích povodí, kde uzáverovým profilem byl vždy zájmový 

hydrologický profil. 
Tabulka 5: Dopočet plochy pro hydrologické profily 

Hydrologické profily Úsek (ř. km) Zdroj Plocha povodí 
[km2] 

ústí do Ohře 0,000 - 4,084 CHMU 46,600 
u Voj nic 4,084 - 4,690 vlastní dopočet 40,911 
nad Suchým potokem 4,690 - 8,573 vlastní dopočet 21,595 

nad rozdělovacím objektem 
do Rosovky 

8,573 - 10,037 ČHMÚ 16,430 

mezi Třebílicemi a Solany 10,037 - 12,863 vlastní dopočet 11,351 
u Kuzova 12,863 - 14,126 vlastní dopočet 5,414 
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Obrázek 16: Mapa profilů poskytnutých od ČHMÚ a profilů dopočítaných 

Poté co jsme stanovili plochy povodí pro jednotlivé hydrologické profily, došlo 

k vypočítání jednotlivých průměrných povodňových průtoků. Ty byly dopočteny 

v aplikaci Excel, a to mezi profily C H M U na základě mocninného trendu a nad profily 

C H M U (v horních úsecích povodí) pomocí extrapolační metody trendu odmocnin 

ploch. Výsledky viz tabulka č. 6. 

Tabulka 6: Průměrné povodňové průtoky pro hydrologické profily 

P o u ž i t ý prof i l 

P l o c h a 
p o v o d í 

( km 2 ) 
Q i Q 2 Qs Q10 Q20 Qso Q100 Q500 Z d r o j 

ú s t í do O h ř e 46.600 6.19 9.89 16.10 21.90 28.70 38.90 48.00 70.00 Č H M Ú 

u Voj nic 40.911 5.62 8.98 14.61 19.88 25.90 35.31 43.58 63.45 d o p o č e t 

nad S u c h ý m 
potokem 21.595 4.24 6.77 10.99 15.00 19.11 26.61 32.85 47.58 d o p o č e t 

nad 
r o z d ě l o v a c í m 
objektem do 

Rosovky 

16.430 4.01 6.41 10.40 14.20 18.00 25.20 31.10 45.00 Č H M Ú 

mezi 
T ř e b í v l i c e m i a 

Solany 
11.351 3.33 5.33 8.64 11.80 14.96 20.95 25.85 37.40 d o p o č e t 

u Kuzova 5.414 2.30 3.68 5.97 8.15 10.33 14.47 17.85 25.83 d o p o č e t 

7.2.3 Tvorba příčných profilů 

Z geodetického zaměření byly získány body jednotlivých příčných profilů. 

Celkem je těchto profilů 225, přičemž jsou zde řazeny i příčné profily jednotlivých 
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objektů na vodním toku. Příčné profily a objekty na vodním toku byly poskytnuty 

z geodetického zaměření v rámci dvou CSV dokumentů. 

Tyto dokumenty obsahují informace o nadmořské výšce těchto bodů, 

zeměpisné délce a šířce, ID profilu a ID bodu, poznámce a kódu. Příčné profily byly 

k dispozici jak pro návodní, tak pro povodní stranu každého dotčeného objektu. 

V práci jsou označovány zkratkami PF. Každý profil, jak již bylo zmíněné výše, 

má svoje jedinečné identifikační číslo, přičemž čím výše od ústí, tím vyšší 

identifikační číslo profil nese. Profily, které charakterizují objekty, označuje 

na návodním profilu velkým písmenem. Přičemž L - lávka, M - most, J - jez 

a S - stupeň. 

Polohopisné údaje poskytnutých bodů bylo nutné převést z prvního kvadrantu 

na kvadrant třetí. 3. kvadrant se od 1. kvadrantu liší tím, že obě souřadnice bodů 

se nachází v záporných hodnotách a sloupce se souřadnicemi X a Y jsou prohozeny. 

Převedení z prvního kvadrantu na kvadrant třetí proběhlo v programu Excel, poté 

došlo k aktualizaci dat (viz kapitola 7.2.1). 

CSV formát byl následně nahrán do programu QGIS. A to přes Open -> Data 

Source Manager -> Delimited Text (viz obrázek č. 17). Zde jsme zadali zdroj CSV 

dokumentu a oddělovač sloupců byl zadán tabulátor. Dále jsme v Geometry 

Definition zkontrolovali správnost sloupců X field, Y field, M field a Z field 

(viz obrázek č. 17). Následně byl příkazem Add CSV soubor přidán do programu 

QGIS, avšak pouze jako formát .txt. Pro vytvoření shapefile vrstvy bylo nutné vrstvu 

uložit: Export -> Save Feature As. 
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Obrázek 17: Data Source Manager 

Následně byla vytvořena zcela nová liniová vrstva s názvem pricne_profily, 

ve formátu .shp. Přes nástroj Edit v programu QGIS byly vytvořeny jednotlivé linie 

příčných profilů z geodeticky zaměřené bodové vrstvy. Přičemž bylo nutné a dbalo 

se na to, aby byly příčné profily vytvořeny z levého břehu na pravý, a to po směru toku 

zkoumaného vodního úseku. Pro vytváření těchto profilů a jejich následnou validaci 

nám pomohl jeden z dostupných Plugins pro QGIS s názevem Qgis2threejs Exportér, 

který umožňuje 3D zobrazování situace. Ten byl v QGIS přidán přes záložku Plugins, 

kde byl vyhledán název pluginu a následně nainstalován (viz obrázek č. 18). 
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Obrázek 18: Instalace Plugins v QGIS 
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Jelikož byla dostupná data o zaměřených objektech v bodové vrstvě, která 

obsahovala i údaje o průběhu dna pod objekty, bylo možné získat příčné profily všech 

objektů, nacházejících se ve zkoumané oblasti. Postup byl stejný jako v případě tvorby 

již předešlých příčných profilů, data byla také poskytnuta stejnou formou (viz obrázek 

č. 19) a nově vzniklé profily byly přidávány do již vzniklé vrstvy pricne_profily. 

Příčné profily nám poskytují informaci o průběhu hladiny koryta, břehů 

vodního toku a jej ich okolí. A tak jsou velice důležité pro následný výpočet 

záplavového území. 

., B i D E F 
1 Číslo bodu y X Z P o z n á m k a < ó d Profil 
2 1 771470,94 1004050,50 166.13 PF_1 

2 771471.67 1004041, SS 166.36 hrana H PF_1 
4 3 771471.73 1004040, SO 166.12 hrana H P F l 
5 4 771471.94 1004033.28 163.69 pata P PF_1 

5 771472.03 1004037.15 163.37 PF_1 
7 6 771472.14 1004035.74 163.81 pata P PF_1 
8 7 771472,16 1004035,54 164.03 hrana H PF_1 

9 8 771472.27 1004034,36 165.24 hrana H PF_1 
. . 9 771472.64 1004029.64 166.10 hrana H P F l 

10 771472.76 1004023.19 166 27 plot k o v o v ý PLK P F l 
i; 11 771410.50 1004050.46 166 17 PF 2 MD 
13 12 771416.00 1004039.78 166.25 hrana H PF 2 MD 
14 13 771417.23 1004037.41 164.36 pata P PF_2_MD 
. ; 14 771417.53 1004036.83 164.26 PF_2_MD 
1S 15 7714.7.95 1004036.01 154.30 pata P PF_2_MD 
. . 16 771415,04 1004035,84 164.55 • í rana H PF_2_MD 
ia 17 771418.4S 10O4O34.9S 164.73 pata P PF_2_MD 

13 771419.39 1004033.21 166.01 hrana H P F 2 M D 
20 19 771419.67 1004032.67 166.19 plot k o v o v ý PLK PF_2_MD 
21 20 771406.15 1004015.22 166.42 PF_2_MOST 
. 21 771403,19 1004013.95 166.3S PF_2_MOST 
23 22 771400.56 1004013,29 166.32 P F 2 M O S T 
24 23 771399.16 1004022.96 166.45 PF 2 MOST 

24 771395.89 1004030.39 166 53 PFJ2_MOST 
ľ 25 771391.44 1004041.16 166.52 PF_2_MOST 

26 771393.72 1004042.29 166.61 PF 2 MOST 
. 27 771387,98 1004039.23 166.45 PF_2_MOST 

28 7714C1.99 1004024.29 166.55 mosty v i d i t e l n á část MO MOA PF_2_MOST 
: . 29 771401,99 1004024.28 166.35 mosty v i d i t e l n á část M OA PF_2_MOST 

. 30 771401,60 1004025,14 166.07 mosty v i d i t e l n á část ; hrana MOA H PF_2_MOST 
31 771401.61 1004024.67 167.59 z á b r a d l í ZA P F 2 M Q S T 
32 771400.87 1004026.73 164.73 mosty v i d i t e l n á část ; pata MOA P P F 2 M O S T 

s 33 771400.90 1004026.67 165.86 mosty v i d i t e l n á část MOA PF_2_MOST 
34 771400.82 1004026.83 166.00 mosty v i d i t e l n á část MOA PF_2_MOST 
35 771400,34 1004027,88 164.58 PF_2_MOST 

. 36 771399.93 1004028,7* 164.66 pata P PF_2_MOST 
ti 37 771399.73 1004029.21 166.06 mosty v i d i t e l n á část MOA PF 2 MOST 

33 771399.67 1004029,34 165 90 mosty v i d i t e l n á část MOA PF 2 MOST 

Obrázek 19: Vzor poskytnutých dat v CSV formátu ze zeměměřičského zaměření 

7.2.4 Tvorba říční geometrie 

Osa toku 

Osa toku byla získána z volně dostupných dat z Centrální evidence vodních 

toků (CEVT). Pomocí funkce Select by Attribute byla získána pouze osa toku 

zájmového vodního toku, která byla dále oříznuta nástrojem Clip na zkoumanou část 

vodního toku. 
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Nicméně u takto získané vrstvy byla zapotřebí její aktualizace, a to dle 

skutečného stavu polohy vodního toku. K tomu nám dopomohla již vytvořená vrstva 

digitálního modelu terénu a linií příčných profilů v kombinaci s ortofotem ČR 

a terénním průzkumem lokality. Důležitá také byla vrstva zaměřených objektů, kdy 

bylo potřeba dohlížet na to, aby linie vodního toku procházela mezi patami mostovek. 

Linie vodního toku by také v ideálním případě, až na pár výjimek, měla procházet 

nejnižšími body příčných profilů. Viz obrázek č. 20, kde je vidět stav původní liniové 

vrstvy vodního toku z CEVT (hnědá linie) a již editované nové liniové vrstvy (červená 

linie). 

Obrázek 20: Rozdíl mezi původní linií vodního toku a námi pozměněnou vrstvou 

7.2.5 Vložení vrstev z QGIS do HEC-RAS 

V programu HEC-RAS byl vytvořen nový projekt pod názvem 

lDGeometryZejdlik. U něho nejprve došlo k nastavení souřadnicového systému 

a jednotek délky u staničení na kilometry, s třemi desetinnými čísly. Následně byl 

v programu otevřen nástroj RAS Mapper, do kterého byl nahrán digitální model 

terénu, tato vrstva byla nahrána do složky Terrains s názvem Terrain. V RAS Mapper 

byla zapnuta Editace -> Import Features From Shapefile. Do Geometries byly 

přidány vrstvy příčných profilů a osy vodního toku. Osy vodních toků do podsložky 

Rivers a příčné profily do podsložky Cross Sections. 
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Do programu byla vložena i bodová vrstva geodetického zaměření s názvem 

ModelGEO_points_ALL. Map Lyers -> Create a New RAS Layer -> Elevation 

Point Layer. Ty nám společně s DMT pomohou v dalším kroku. 

7.2.6 Příčné profily v HEC-RAS 

Po vložení příčných profilů do HEC-RAS, bylo potřeba příčné profily rozšířit. 

V našem případě byly nejprve veškeré profily rozšířeny po levé i pravé straně 

o 50 metrů. V záložce Geometrie Data -> GIS Tools -> GIS Cut Lines -> Extend Cut 

Lines and Sta/Elev -> Add to the Left/Right. Tímto způsobem byly všechny profily 

automaticky rozšířeny (viz obrázek č. 21). 

Obrázek 21: Rozšíření příčných profilů v Geometrie Data 

Po tomto kroku se přešlo opět do prostředí Ras Mapper, kde byly pomocí 

editace dále upravovány příčné profily v podsložce Cross Sections. A to za pomoci 

podkladové mapy DMT. Nově rozšířené profily se dále upravovaly, buďto se 

zkracovaly nebo ještě více protahovaly, a to na základě DMT, kdy se uvažovalo, kam 

až by mohlo dojít k rozlivům během povodňových situací. Nesmírně důležité také 

bylo, aby se profily nepřekrývaly a aby se u profilů nezměnila poloha v zaměřených 

místech (viz obrázek č. 22). Po takto vytvořených úpravách došlo k dopočítání 

staničení a vzdálenosti jednotlivých profilů. Cross Sections -> Update Cross Sections 

-> Reach Lenghts/Bank Stations. 

52 



Obrázek 22: Úprava příčných profilů 

7.2.7 Vytváření mostů a dalších objektů v programu HEC-RAS 

V dalším kroku došlo za pomoci již výše zmíněných vrstev Terrain 

aModelGEO_points_ALL kpropsání přesných nadmořských výšek do příčných 

profilů. V Cross Sections -> Update Cross Section -> Elevation Profiles from Points. 

Tím se do liniové vrstvy příčných profilů, které protínají svá místa s vrstvou 
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ModelGEO_points_ALL, propsala nadmořská výška zaměřených bodů. V jiných 

místech se do příčných profilů propsaly informace o nadmořské výšce z digitálního 

modelu terénu. Tato změna je patrná z obrázku č. 23, kde je vidět rozdíl mezi 

nadmořskou výškou z D M R a nadmořskou výškou dostupnou z geodetického 

zaměření. 

Poté, co došlo k propsání informací o nadmořské výšce do příčných profilů, 

se mohlo přejít k vytvoření objektů v prostředí RAS Mapper v rámci editoru 

geometrických dat. A to tak, že v Geometrie Data -> Bridge Culvert Data -> Options 

-> Add a bridge and/or Culvert... Zde se při každém přidání objektu aplikace tázala 

na staničení objektu, které bylo vypočteno tak, že se sečetlo staničení mezi dvěma 

profily objektu a následně se vydělilo dvěma. Ke každému staničení se tak 

automaticky přiřadily dva profily, a to k povodní a návodní straně daného objektu. 

Poté jsme přešli již ke geometrii objektu, kterou je také nutné vyplnit u každého 

objektu. Jedná se o Distance - vzdálenost od výše položeného příčného profilu 

k návodní hraně objektu, Width - šířka objektu, Weir coef - součinitel přepadu 

(viz obrázek č. 24). Přičemž Weir Coeficient byl u mostů uvažován s hodnotou 1,4 

a u ostatních objektů 1,77. Na obrázku č. 24 lze nalézt i informace o návodní a povodní 

straně objektu (Upstream a Downstream), a jej ich horních a dolních nadmořských 

výškách (high chord a low chord). Ty byly také pro jednotlivé objekty kontrolovány, 

popřípadě pozměňovány, aby odpovídaly skutečnosti. 
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Obrázek 23: Rozdíl mezi DMR a geodetickým zaměřením 
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Deck/Roedway Data Editor 

Distance Width Weir Coef 

M 5 . : 1 .4 

Copy US to DS 

Downstream 

Station hi oh chord low chord Station hich chord low chord 
1 91.72 255,71 
2 94.99 25 5.69 254.94 
3 95,7 255,66 254,95 
4 101.37 25S.63 254.94 
5 101,96 255.6 254.97 
6 los.rji 255,55 255,2 
7 116.53 255.52 
R 

U.S Embankment SS JO 

Weir Data — 

D,S Embankment SS |5~ 

Max Submergence: |o.9S 

Weir Crest Shape 
(• Broad Crested 
C Ogee 

Min Weir Flow El: 

OK Cancel 

^nter distance between upstream cross section and deck/roadway, (m) 

Obrázek 24: Příklad editace geometrických dat objektu v rámci prostředí RAS Mapper 

7.2.8 Břehové linie (Bank Lines) 

Nyní došlo v modelu TIN k vytvoření vrstvě břehových linií. U každého 

profilu na vodním toku byly zadány břehové body pro levý a pravý břeh, a to zadáním 

jejich staničení. V Geometrie Data -> Cross Section Data -> Main Channel Bank 

Stations, byly vybírány údaje o Left Bank a Right Bank (viz obrázek č. 25). Byly tak 

vytvořeny po obou stranách vodního toku. Toto staničení však bylo přidáno graficky. 

A to přes funkci v Cross Section Data -> Jump to the Graphical Cross Section Editor. 

Tak se dostaneme do Graphic XS Editor (viz obrázek č. 26), kde stáničíme Left Bank 

a Right Bank ručně, za pomoci Set the Bank Station. Břehové linie v modelu 

představují břehovou čáru, která má vliv na tvorbu koryta programem. 

'-• trtH ĚKliůrt Dili - lD_Gtůitlílty_Iíjdlik 

bit Edit Option* Plot -cr. 

_i£j 1» »5 
"í] 16,473 •-
i » 7 4 j <-

10.06 0.06 10.06 

1 Left-Bank 
|L!7,*3 

SHÜBBLCII 

Zejfllilí_2022 Pian: QH_5lsariy 67212022 

OH Mcaaiedling 

Obrázek 25: Břehové body -Left Banks a Right Banks 
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Graphic XS Editüi 

Für Option: 

ihrtr; | River 1 

Descnpiion |Pf_9_MQST_D 

"31 r Peraistait Suk 

3 Al-íl F Compare Geometry Fifes 
T Update Compare X5 

Ground 
* 

175.26.1G9.9S 

Obrázek 26: Břehové body - Graphic XS Editor 

7.2.9 Zadání průtokových dat 

Pro správnou simulaci povodňových průtoků bylo nutné přidat data 

o návrhových průměrných povodňových průtocích pro vybrané příčné profily. Pro dva 

profily byly tyto údaje získány od C H M U a další čtyři byly vypočítány 

(viz kapitola 7.1.2). 

Pro vložení údajů do Hec-Ras jsme v hlavním panelu aplikace přešli nástroje 

View/Steady Flow Data - Edit. Zde jsme v záložce River sta. vybrali požadovaný 

profil a přidali j ej přes Add a Flow Change Location. Poté j sme k takto vytvořenému 

úseku vodního toku přidali známé informace o průtocích, a to z tabulky č. 6), a to pro 

Q5, Q10, Q20, Q50, Q100 a Q500. Výsledek lze nalézt na obrázku č. 27. 

Dále zde byly zadány okrajové podmínky. A to přes Reach Boundary 

Conditions, kde byla okrajová podmínka vybrána jako typ Critical Depth, v překladu 

kritická hloubka. Tím bylo docíleno automatického dopočtu okrajové podmínky 

ze strany programu. 

Steady Flow Data - QN.rtearty 

File Options HeJp 

Description : | 

Enter/Edit Number of Profiles <32000 max): 

^ Apply1 Dala I 
Reach Boundary ConCitons.,. 

Rii*r 1 
Add Multplř... 1 

Reach 1 * | Rhľŕff 5ra.:|3.99 » | Add A Flow Change Location | 

River Kžč í l US o- v 05 OlO O20 Q50 lo ioo k 5'.! 
1 River 1 Reach 1 14.126 2.11 2.37 519 7 . « 9.73 13.26 16.36 23.66 
? River 1 Reach 1 12.7129 3.W 4.38 7,95 1 0 . í l 14.16 19.20 23.69 34.55 

River 1 Reach 1 9 , 6 « 1 4.01 D.41 10.4 14.2 ta 25.2 31.1 45 
River 1 Reach 1 B.5975 1.̂ 9 7.1S 11.66 15.91 20.34 28.24 31.35 SO.53 
River 1 Reach 1 5.66 9.37 15.24 20.75 27.08 36.35 15.-7 66.24 

ŕ River 1 Reach 1 3.99 É. 19 9.39 16.1 21.9 23.7 3S.9 48 70 

tdjt steady flow data for the profiles (m 3/s} 

Obrázek 27: Zadání okrajových podmínek v nástroji Steady Flow Data 

57 



7.2.10 Zadání drsností 

Tato proměnná nám v modelu udává jakýsi odpor pro rychlost proudění vody. 

Do Hec-Ras byla drsnost zadána pomocí tzv. Manningova součinitele drsnosti n. 

Přičemž na různých površích se tyto hodnoty liší. Platí, že čím vyšší odpor povrchu, 

tím vyšší číslo Manningova součinitele drsnosti n. Drsnosti byly zadány dvěma 

způsoby. A to jak pro koryto, tak pro inundační území. Drsnosti byly zadány s ohledem 

na nejvíce nepříznivý případ, tedy pro vegetační období. 

Pro inundační území a celé okolí vodního toku byly použity shapefile vrstvy 

drsnosti z mapy land cover (viz obrázek č. 12). Pro převod různých typů povrchů byla 

použita tabulka č. 7. V QGIS byly vytvořeny dle podkladových map vrstvy land cover 

a budov, následně jim byly přiřazeny hodnoty z tabulky č. 7 do nově vytvořeného 

sloupce v atributové tabulce s názvem Nmanning a následně byly tyto vrstvy 

importovány do Hec-Ras. V Rasmapper -> Map Layers -> Create a New Ras Layer 

-> Land Cover Layer. V této záložce byla nejprve přidána vrstva land cover a poté 

vrstva budov. Pro obě vrstvy byly nastaveny hodnoty ze sloupce atributové tabulky 

Nmanning. 

Dále pak byly přidány hodnoty Manningova součinitele drsnosti n pro koryto 

řeky. Tyto drsnosti byly přidávány pro všechny profily dle fotodokumentace 

k příčným profilům a dle ortofota České republiky, a to také dle hodnot Manningova 

součinitele drsnosti - n z tabulky č. 7. V Hec-Ras -> Geometry Data -> Tables -> 

Manning's n orkvalues (Horizontally varied) (viz obrázek č. 28). Zde byly pro 

každý profil zadána data o drsnosti pro koryto, levý a pravý břeh. 

Tabulka 7: Odhad drsností pro N-leté průtoky (Manningův součinitel drsnosti - n) 

Odhad drsností pro N-leté průtoky (Manningův součinitel drsnosti - n) 

drsnost v korytě 

Koryto upravené, přímé, kamenná dlažba 0,040 

drsnost v korytě 

Koryto upravené, přímé, betonová nesouvislá dlažba 0,040 

drsnost v korytě Koryto upravené, přímé zatravněné břehy 0,042 drsnost v korytě 
Koryto upravené, přímé, zatravněné břehy s občasným 
křovím 

0,044 
drsnost v korytě 

Koryto přirozené 0,048 

drsnost 
v inundaci 

Průmyslové areály 0,100 

drsnost 
v inundaci 

Bažiny, močály 0,040 
drsnost 
v inundaci Kolejiště 0,050 drsnost 
v inundaci 

Lesní půda se stromy 0,080 

drsnost 
v inundaci 

Lesní půda s krovinatým porostem 0,100 
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Odhad drsností pro N-leté průtoky (Manningův součinitel drsnosti - n) 
Okrasné zahrady, parky 0,060 
Orná půda 0,050 
Komunikace včetně chodníků 0,040 
Ovocné sady 0,060 
Parkoviště 0,035 
Travní porosty 0,050 
Vodní plochy 0,035 

File Edit Options View Tables Tools GISTools Help 

Mannings n or V. values (Honzontally varied)... 

Reach Utflgths ... 

ContracliorAEspansion Coefficients (Steady Flow)... 

Contraction' Expansion Coefficients (Unsteady Flow)... 

Minoi Losses.... 

Bank Stations... 

Levees... 

let Cover... 

Names. 

PictureFileAssociations... 

Ineffective Flow Av%$5 ... 

Blocked Obstructions... 

Bridge Width Table ... 

Wetrand GateCoeff Table,.. 

HTab Internal Boundaries Table... 

Linear Routing Coefficients... 

PriMsmann't Slot on Lidded XShs ... 

Manning's n by Land Cover... 

Obrázek 28: Manningův součinitel drsnosti pro koryto řeky 

7.2.11 Spuštění ustáleného proudění 

Poté, co byly všechny vrstvy připraveny a kroky z předchozích kapitol 

nastaveny, mohlo se přejít k výpočtu simulace ustáleného proudění. Tohoto kroku 

se docílí přes hlavní panel programu HEC-RAS, v záložce Perform a steady flow 

simulation. Tento panel nám otevře záložku s názvem Steady flow Analysis. 

Zde zvolíme složku s vybranou geometrií, v našem případě 1Ľ Geometry Zejdlik. 

Nadále je zapotřebí vybrat správný typ proudění. Nabízejí se 3 možnosti: Subcritical 

(pro bystřinné proudění), Supercritical (pro říční proudění) a Mixed (pro kombinaci 

předchozích typů). V našem případě byl zvolen typ Mixed, jelikož se jedná o úsek 

řeky, ve kterém se musí brát ohled jak pro bystřinné proudění v horních úsecích, tak 

pro říční proudění v dolních úsecích. Samotná simulace je spuštěna pomocí tlačítka 

Compute. 

Často se při prvních testech výpočtů naráží na chybové hlášky. Například 

na upozornění, že příčné profily přesahují nejvyšší možný počet bodů, nebo má 

program například problém s velice blízkými hodnotami, které bere jako duplicitní. 

Dále pak má model často problémy se staničením u levé či pravé mostovky a je třeba 
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jej lehce zaokrouhlit. Všechny chybové hlášky bylo nutné vyřešit pro správný výpočet 

simulace. Výsledky lze následně najít v Ras mapper. 

7.3 Postup zpracování 1D2D modelu 

Problémem u ID modelu je však to, že v některých místech dochází k zaplnění 

prohlubní v okolí vodního toku bez toho, aniž by došlo k vybřežení povodně z koryta 

(viz obrázek č. 29 a obrázek č. 30). Proto byla také vytvořena kombinace ID a 2D 

modelu, kdy nám ID model sloužil jako zdroj dat a jeho výsledky sloužily také jako 

zdroj informací. Díky tomu byla vytipována místa, kde by bylo dobré nahradit ID 

model 2D modelem, kvůli chybám v rozlivech u ID modelu. 

Tento model tak počítá ID model pro koryto, pro objekty na vodním toku a pro 

části inundačního území, které vychází správně. 2D model pak počítá inundační území, 

které vycházelo špatně z ID modelu. Horní úsek toku tak byl vypočten pomocí ID 

modelu. Od říčního kilometru 11,1408 až po ústí do Ohře, byla použita kombinace 

1D/2D modelu, kdy velice převažoval 2D model. 

f fe PfOftcl Tooíi 
.fit.*; .) ? 

B • Inlirw arudm 

• jrittsí,-

• QSft.ymiMd, 

• Q5_imMr J 

H H QN_tK*íy_WM 

• "CCtL OLO pm tu. 

• . | ^ g H 1 | P w H . U » | j k f r v i F w j U i i 

Obrázek 29: Oblast chybové vybřežení u ID modelu 
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Obrázek 30: Projekce chybového vybřežení ID module u vybraného příčného profilu 

Pro vytvoření 2D modelu byla převzata data z ID modelu. A to tak, že data 

z Geometry Lata — ID Geometry Zejdlik, byly uloženy jako 

1D2D Geometry Zejdlik. Vznikla tak kopie dat z ID modelu. Tato vrstva 

geometrických dat byla následně upravována. 

7.4 Tvorba 1D2D modelu 

V místech, kde chceme vytvořit 2D model, došlo ke zkrácení příčných profilů. 

A to na nejvyšší místo v levém i pravém břehu řeky, maximálně na úroveň břehovek. 

V Geometrie Data -> Cross Section -> Jump to the Graphical Cross Section Editor 

-> Delete Objects. Nebo v Geometric Data -> Cross Section -> Cross Section 

Coordinates -> zde umazávat ručně. Pro zkrácení profilů byly použily oba postupy. 

V místech střetu ID modelu s 2D modelem je třeba pro správný chod modelu 

nastavit propojení těchto modelů. A to prostřednictvím Lateral Structure, tzv. boční 

přeliv. Ty byly přidávány z Ras Mapper -> 1D2D Geometry Zejdlik -> Edit -> 

Lateral Structures -> Add New Feature. Kdy bylo zapotřebí tyto boční přelivy 

editovat po směru proudění vodního toku. 

Po vytvoření Lateral Structures byly přidány 2D oblasti pro výpočet 2D 

modelu. Ty byly přidávány ručně tak, aby z jedné strany byly ohraničeny Lateral 

Structures a z druhé strany zasahují do míst, kde již nemůže dojít k rozlivu ani u Q500. 

K vytvoření těchto oblastí došlo prostřednictvím: Ras Mapper -> 

1D2D Geometry Zejdlik -> Edit -> 2D Flow Areas -> Perimetres -> Add New 
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Features. Po vytvoření oblasti se nesmí zapomenout pojmenovat oblast a vygenerovat 

výpočetní body 2D sítě (tzv. Computation Points), jejichž rozmezí bylo nastaveno 

na 10 m. K tomuto nastavení došlo v dialogovém okně 2D Flow Area Editor. 

Pro vygenerování sítě se zadá v 2D Flow Area Editor -> Generate Computation 

Points with All Breaklines (viz obrázek č. 31). 

ID Flow Area Editor • 
20 Flow Ares: 

Prapertiaa j 
Computation Panů 

LEFT střed 

Poiíits Spoang f m) | Ü> DY. | 10 * * \ 

Generate Computation Pointe with All Breaklines 

Generate Crjmput&tiDn Points wilrWul Ereak ires 

Average Face Length » 0 
Average Cel Sue =0 
U^uijn Call Sz» - • 
Minilum Cell Sue = 0 
QJnl Status = Mesh not creaied 

hydraulic Cel I. Face Properties 
Default Manning.'* n Value: [ 0 06 ConcLrte Property Tables 

F-rrrř iter Rerr-np .:a:i~n Owe 

Obrázek 31: Práce v 2D Flow Area Editor 

V dalším kroku bylo potřeba v Geometrie Data zadat informace, na j aké straně 

vodního toku se nachází Lateral Structures, a k jakým 2D Flow Areas jednotlivé 

Lateral Structures patří. K nastavení výše zmíněného došlo v Geometrie Data -> 

Lateral Structure Editor. 

Dále pak byly vytvořeny tzv. Breaklines. Tyto liniové prvky při generování 

2D sítě vždy rozdělí buňky {Computation Points) na dvě. Vytvářejí se především 

u cest, železnic, mostů, násypů atd. Důvodem je, aby 2D síť reflektovala tyto objekty 

a jejich nadmořskou výšku (viz obrázek č. 32). Breaklines se vytvořily v Ras 

Mapper -> Geometries -> 1D2D Geometry Zejdlik -> 2D Flow Areas -> Breaklines 

-> EDIT. 
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Obrázek 32: Nastavení Breaklines 

7.4.1 Zadání průtokových dat do 2D modelu 

U 2D modelu se zadávají data o průměrných průtocích odlišně, než jak tomu 

bylo u ID modelu. Tato data se zadávají v záložce Unsteady Flow Data, a patří 

k takzvaným okrajovým podmínkám. Okrajové podmínky se vkládají pro jednotlivé 

scénáře zvlášť (Qi, Q2, Q5, Q10 atd.), a to pomocí záložky File -> New Unsteady Flow 

Data. Tímto způsobem vytvoříme celkem sedm scénářů (viz obrázek č. 33). 
J L , Unsteady Flow Data - G1_unsteady 

File Options Help 

Open Unsteady Flow Data .., 
Save Unsteady Flow Data 
Save Unsteady Flow Data As .,. 
Rename Unsteady Flow Title .., 
Delete Unsteady Flow File.,. 

Set Initial Conditions [flow and stage for 1DJ from previous output profile ,. 

Exit 

UdRS... I Add SA/2D Flow Area.., I Add Conn... I Add Pump Sta ... 

^ JU 

River Reach R 5 Boundary Condition 
1 River 1 Reach 1 : 1. L408 Horn H-cdrograph 

: River 1 RciJ i : r.-5^4: Lateral Inflow Hvdr. 
3 River 1 Reach 1 3, 5 3 7 5 Lateral Inflow Hvdr. 
-1 River 1 Reach : Lateral Inflow Hydr. 

Rivei . 3 , 5 9 Lateral In flow Hvdr. 
6 R • -ei '. Reach 1 10241 Stage Hydrograph 

St onage/ZD Flow A eas Boundary Condition 
1 LB 01 BCLine: DOP odtok 
2 LB Q1 BCLine: DOP Leva 
3 Rß Ol BCLine: DOP PTŮVŮ 

Obrázek 33: Vytvoření N-letých scénářů 
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V Unsteady Flow Data jsou zadávány profily, u kterých je potřeba vložit 

průtoková data, a to pomocí nástroje AddRS ... Narozdíl od Steady Flow Data, zde 

průměrné průtoky přičítáme tak, že počátečnímu profilu přiřadíme okrajovou 

podmínku s názavem FlowHydrogram, v případě Q5 je to 5,97 m3/s. Poté se k tomuto 

„počátečnímu" profilu přičítají hodnoty průměrných průtoků v místech, kde se síla 

povodně navyšuje (viz tabulka č. 8). 

Na závěr se ještě zadává dolní okrajová podmínka, tzv. Stage Hydrograph. 

Jako dolní okrajová podmínka byla použita známá úroveň hladiny mezi dvěma profily 

na Ohři ze Studie záplavového území, úsek Křesín - Louny (Vodohospodářský rozvoj 

a výstavba a.s., 2018). Z této studie vyplývá, že dolní okrajová podmínka Žejdlíku pro 

průtoky Qi až Q50, odpovídá úrovni hladiny v recipientu Ohři Qi . A dolní okrajová 

podmínka pro průtoky Q100 až Q500, odpovídá úrovni hladiny v recipientu Ohři Q5 

(viz Tabulka 9). 

Tabulka 8: Rozdíl v zadávání okrajových podmínek mezi Steady Flow Data a Unsteady Flow Data 
v programu Hec-Ras 

Q 5 

profily Steady Flow Data (m3/s) Unteady Flow Data 

(m3/s) 

u Kuzova 5,97 5,97 

mezi Třebívlicemi a 

Solany 
8,64 + 2,67 

nad rozdělovacím 

objektem do Rosovky 
10,40 + 1,76 

nad Suchým potokem 10,99 + 0,59 

u Voj ni c 14,61 + 3,62 

ústí do Ohře 16,10 + 1,49 

Tabulka 9: Úrovně hladin Ohře použité jako dolní okrajová podmínka Žejdlíku 

Převzatá úroveň hladiny na Ohři (m n. m.) 

Qi Qs 
Ustí do Ohře 166,28 167,22 

7.4.2 Nastavení výpočtů 1D/2D modelu 

Poté, co dojde k správnému nastavení všech předchozích kroků, může se přejít 

ke konfiguraci samotného výpočtu. Ten probíhá přes záložku Unsteady Flow 
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Anatysis, tedy jako analýza simulace neustáleného proudění. Podle HEC-RAS (2019), 

se tento typ simulace neliší zásadně od simulace ustáleného proudění. Oba modely 

využívají stejné hydraulické výpočty, avšak jejich výpočetní rovnice jsou různé. 

Jednotlivé N-letosti průtokových scénářů se počítají zvlášť, přičemž je ideální, 

aby všechny N-letosti měly nastaven stejný časový interval. Ten nastavíme 

ve sloupcích Starting Time a Ending Time. Přičemž výpočty byly nastaveny 

na 24 hodin (viz obrázek č. 34). Dále pak byl nastaven výpočetní interval procesů, 

které se mají programem vypočítat (viz obrázek č. 34). Ten by měl také splňovat 

Courantovy podmínky, při níž je základem to, že výpočetní interval by měl být stejný 

nebo kratší než čas, za který voda přejde z jednoho příčného profilu do druhého. Poté 

již došlo ke spuštění jednotlivých výpočtů. 

jS l , Unsteady Flow Analysis 
File Options Help 
Flan: |qi_unsteady_l 

Geometry Fie: 
Short ID: |Ql_unsteady_l 

I lD2D_Geometry_Zeidl!_v8Jv 
Uns teady Flow Fie: Q l_uns teady 
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Programs to Run 
W Geometry Preprocessor 
[7 Unsteady Flow Simulation 

[~ Sediment 
W Postprocessor 
r~ Floodplain Mapping 

Plan Description 

|22SEP2008 
Startina Time; 
Ending Time: 

Ü : Ü : 

|2400| 

Simulation Time Window 
Staring Date: 
Ending Date: 

Computation Settings 
Computation Interval: 
Mapping Output Interval: 
| Project DSS Fiename: T] |c:YJserstfomdesktop v3ejt*k_2022_4\Zejdit_20Z2.dss Sf\ 

1 Second Hydrograph Output Interval: 11 Hour 
30 Minute Detailed Output Interval: |lHour }̂ 

Mixed Flow Regime (ID only] is enabled. 

Compute 
Obrázek 34: Nastavení výpočtů Unsteady Flow Analysis 

7.5 Generování výsledků a postprocessing 

Vygenerování výsledků proběhlo n Ras Mapper -> Tools -> Create 

MultipleMaps. Zde byly vybrány výsledky výpočtů pro jednotlivé scénáře. Jak pro ID 

model, tak pro 1D/2D model. Veškeré scénáře byly generovány pro stejný časový 

krok, přičemž došlo k vytvoření shapefile vrstev inundačního území. 

Ty byly následně nahrány do programu QGIS, kde byly upravovány do finální 

podoby a následně kontrolovány. Došlo k propojení inundačního území ID modelu 
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s 1D/2D modelem pro jednotlivé N-leté scénáře v profilu, nacházejícím se v říčním 

kilometru 11,1408. Poté bylo v QGIS využito nástroje na panelu Advanced 

digitalizing toolbar, který nám pomohl zaplnit určité díry v shapefile vrstvě rozlivů, 

spojit oblasti které by na sebe měly navazovat, zbavit se kostrbatých hran,... Důležité 

taky bylo verifikovat tzv. superpozici záplavových území, kdy se kontrolovalo, zda 

rozlivy nižších N-letostí nepřesahují rozlivy vyšších N4etostí. Těmito kroky došlo 

ke stanovení záplavových ploch pro jednotlivé N-leté průtoky. 

7.6 Hydrotechnické posouzení objektů 

Díky vyhodnocení simulací modelů pro jednotlivé N-leté scénáře, mohly být 

z hydrotechnického hlediska posouzeny objekty nacházející se na řešené části vodního 

toku. Díky hydrotechnickým výpočtům tak může dojít k hydrotechnickému posouzení 

objektů. Jak uvádí Zuna (2004), tyto výpočty patří mezi podklady pro projekty 

vodohospodářských staveb, pro posuzování bezpečnosti vodních děl, pro posuzování 

převedení povodňových průtoků přes objekty na vodních tocích, používají se jako 

podklad pro projektanty staveb ovlivňujících vodní tok, což jsou např. mostky, 

propustky, stavby v záplavových územích apod. Došlo tak k posouzení 30 mostů, 

14 lávek a 1 propustek, a to z hlediska kapacity objektů při různě silných povodní. 

Pokud výška hladiny N-letého průtoku dosáhne či přesáhne výšku spodní hrany 

objektu, jedná se o objekt nekapacitní. V takovém případě dochází k vybřežení vody 

přes objekt a může v místě problému dojít k velkým rozlivům, či může být poškozena 

statika objektu. ČSN 73 6201 „Projektování mostních objektů" (2008) pak definuje 

největší průtok protékající profilem toku v místě mostního otvoru jako kapacitu 

mostního otvoru. 

Data získaná z modelu byla následně upravena v excelu a vznikla přehledná 

tabulka, ve které lze najít především výšky jednotlivých hladin při N-letých povodních 

a spodní výšky konstrukcí objektů nacházejících se na vodním toku (viz příloha č. 1). 

Na základě těchto údajů byly následně vytvořeny pro pět vybraných objektů evidenční 

listy objektů (viz příloha č. 11 - příloha č. 20). Dále pak byla vytvořena přehledná 

tabulka s informacemi o jednotlivých objektech a jejich hydrotechnickém posouzení 

kapacity při Qs, Q20, Q100 a Q500. Rozděleny byly do tří kategorií: kapacitní, zahlcený, 

zahlcený a přelévaný (viz příloha č. 2). 
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8 Výsledky 

8.1 Vyhodnocení výsledků záplavových území 

Za hlavní cíl si diplomová práce zadala stanovení záplavových čar, a tím 

vymezení záplavového území. A to na řešeném úseku 0,000 - 14,126 ř. km, pro N-leté 

průtoky Qs, Q20, Q100 a Q500. Pro stanovení těchto výstupů bylo využito programů 

HEC-RAS a QGIS. Výsledné mapy jsou k dispozici v příloha č. 3 až v příloha č. 10. 

Z těchto výsledků vychází, že při průtoku Q5 nedochází k významnějšímu 

vybřežení v intravilánu. Povodní je ohroženo pouze pár budov, a to pouze lokálně. 

Zasaženy jsou především louky. I přes to již při Q5 lze označit rozlivy na některých 

místech za poměrně rozsáhlé. Viz obrázek č. 35, který vyobrazuje rozliv povodně 

u obce Solany, v ř. km 9,160 - 8,390, kde dochází v intravilánu k vybřežení v těsné 

blízkosti koryta do místních zahrad. Pod obcí, kde koryto neprochází údolnící, jsou 

rozlivy většího rozsahu. Zasaženy jsou však pouze luky a pole. 

U obce Vojničky, v ř. km 5,290 - 4,730, jsou rozlivy při Q5 také rozsáhlé, 

ale zasahují pouze do pozemků luk a polí (viz obrázek č. 36). Nad obcí rozlivy 

reflektují historický zaniklý rybník. 

Obrázek 35: Rozlivy při Os u obce Solany 
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Obrázek 36: Rozlivypři Os u obce Vojničky 

Při povodňových průtocích Q20 dochází k vybřežení již v horních úsecích 

modelované oblasti. Avšak k významným rozlivům dochází až u obce Třebívlice 

a Solany. Především v Solanech dochází k ohrožení značnému množství budov. 

Vř . km 10,630 - 8,610 povodeň rozděluje povodňové průtoky na dvě hlavní 

proudnice, kdy jedna prochází upraveným korytem a druhá přirozenou údolnicí 

tvořenou zaniklým rybníkem v obci Solany (viz obrázek č. 37). U ústí do Ohře, v ř. km 

0,890 - 0,000, je průběh povodně ovlivněn křížením s hlavní komunikací, kdy dochází 

ke vzdutí hladiny a přelévání komunikace levým inundačním územím, kde je ohroženo 

několik nemovitostí (viz obrázek č. 38). 

Obrázek 37: Rozdělení proudnice při O 20 u obce Solany 
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Obrázek 38: Rozlivy při O20 u ústi do Ohře 

Při průtoku Q100 dochází k vybřežení v celém spodním úseku vodního toku. 

K významnému rozlití dochází téměř ve všech zastavěných územích. Objekty na toku 

jsou z velké části nekapacitní, vlivem čehož voda proudí po přilehlých komunikacích. 

V obcích je zasaženo velké množství budov. Některé budovy jsou ohroženy 

již v horním úseku vodního toku. V popisovaném kritickém místě obce Solany 

je ohroženo až několik desítek budov (viz obrázek č. 39). Rozliv v místech ústí 

do Ohře a odtokové poměry do značné míry korespondují s rozlivem při průtoku Q20. 

Obrázek 39: Rozlivy při Qwo u obce Solany 

Povodně Q500 se zásadně neliší způsobem rozlivů od povodní při Qioo, jejich 

území je ovšem větší a jsou nebezpečné pro více budov. 
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K jednomu z nej problematičtějších míst z pohledu průběhu povodně patří 

zmiňovaná obec Solany na ř. km 10,400 - 8,400. Zde dochází k rozdělení proudění 

povodňových průtoků a ohrožení značného území intravilánu zmiňované obce. Terén 

je zde téměř rovinatý. Avšak trasování toku je oproti historickému upraveno 

a neprochází přirozenou údolnicí. Z podkladu 2. vojenského mapování je vidět 

historický zaniklý rybník a původní trasa koryta. S tímto pokladem korespondují 

rozsahy rozlivů do levého inundačního území (viz 6.2). 

Dále pak v místní části Vojničky je nekapacitní silniční mostek (ř. km 5,102) 

a dochází zde k rozlivům již od Qs. Rozliv se se propaguje již z nad obcí, kdy je 

zaplavena v podstatě celá šíře nivy. Jedná se o lokalitu bývalého rybníka (viz obrázek 

č. 40). 

V lokalitě ústí dochází k výraznému ovlivnění rozlivů na vodním toku Žejdlíku 

vlivem vzdutí recipientu Ohře. Díky tomu dochází již k rozlivům od Qs mimo koryto 

vodního toku. Od Q20 dochází k výraznějším rozlivům do oblastí rezidenční zástavby, 

včetně lokality železniční stanice Košetice nad Ohří (viz obrázek č. 41). 

Obrázek 40: Obec Vojničky z 2. vojenského mapování (CENIA 2022) 
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Obrázek 41: Rozlivy Žejdlíku v lokalitě ústím do recipientu Ohře, obec Koštice 

8.2 Výsledky hydrotechnického posouzení vodního toku 

Z výsledků studie dále vyplývá, že mnoho objektů na vodním toku je během 

povodní nekapacitních. A to i při Q20 nebo dokonce již při Q5. Často tak může v těchto 

lokalitách dojít vlivem vzdutí kvybřežení vodního toku Žejdlík (viz příloha č. 2). 

V tabulce č. 10 pak lze naleznout objekty, které ovlivňující v řešeném úseku vodního 

toku, rozlivy nejvýznamněji. 

Tabulka 10: Objekty, které významněji ovlivňují rozlivy 

Staničení 
(ř. km) 

ID objektu Typ objektu 

0,552 PF_14_M most 
0,943 PF_20_M most 
3,003 PF_31_M most 
5,102 PF_50_M most 
8,608 PF_90_S vzdouvací a rozdělovači objekt 
11,773 PF_178_M most 
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9 Diskuse 

Hlavním výstupem diplomové práce bylo stanovení záplavových území, tyto 

výsledky však mohou být ovlivněny mnoha faktory a mohou se tak lišit od reality. 

Tato kapitola se zabývá právě těmi činiteli, kteří mohou mít vliv na prezentované 

výsledky. 

Největší vliv na výsledky mají bezesporu vstupní data. D M R 5G má střední 

chybovou odchylku 0,18 - 0,3 m. Tato možná odchylka v nadmořské výšce přilehlého 

okolí vodního toku může mít zásadní vliv při modelaci povodňové vlny. 

I zaměřené objekty a příčné profily se mohou lišit od reality a způsobovat tak 

určité nepřesnosti. Vždy totiž platí, že čím více zaměřených bodů, tím více se zaměření 

shoduje s reálnou situací. Avšak nemůže být zaměřeno nekonečně mnoho bodů. 

Samozřejmě je mnohem přesnější mít příčné profily geodeticky zaměřené, než 

se spoléhat pouze na letecké laserové skenování. Například Paul a spol. (2020) uvádí, 

že i to je v některých případech možné, musí se však počítat se značnou chybovostí 

výsledků. V této práci však bylo použito přesnější varianty, a byly použity geodeticky 

zaměřené příčné profily. 

Další chybovost výsledků mohou způsobovat vstupní hydrologická data. 

Ta mají IV. třídu přesnosti, a tudíž mohou mít vysokou chybovost. Pokud však bereme 

v potaz velikost vodního toku a s ním spojenou dostupnost dat, tak byly pro vstupní 

data využity ty nej lepší možné zdroje. 

V neposlední řadě může být model ovlivněn lidským faktorem. Tím je myšlen 

samotný tvůrce modelu. Kdy platí, jako v mnoha jiných případech, že čím větší 

zkušenosti, co se týče práce s těmito modely, tím se zmenšuje pravděpodobnost tvorby 

určitých chyb, a tím pádem i docílení lepších výsledků. 

Co se týče podobnosti zpracování, diplomová práce se odlišuje pouze 

minimálně. Studie záplavové území DHI a.s. (2021), studie Povodí Labe (2020) 

i studie od Hydrosoft Veleslavín s.r.o. (2020) se neliší od této práce, co se týče 

podkladových dat. Všechny tyto studie využívají jak D M R 5G, tak geodetické 

zaměření koryta a objektů na vodním toku. Hydrologická data mají ovšem v lepší třídě 

přesnosti, jelikož se v úsecích jejich studie nachází měřené hydrologické profily. 

Studie Povodí Labe i studie DHI a.s. využívají pro modelaci povodní software 

Mike 21, zatímco diplomová práce a studie od Hydrosoft Veleslavín využívají 

72 



softwaru HEC-RAS. Nicméně výpočetní postupy se v zásadě neliší. Některé studie 

počítají ID model, jiné zas 2D model, a to dle zadání objednavatele. 

Je těžké určit, zda jsou výpočty a samotné výsledky u jednotlivých studií 

přesnější či s menší chybovostí, jelikož každá studie se zabývá jiným územích, a tak 

je nelze přímo porovnávat. 
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lOZávěr 

Diplomová práce měla za cíl sestavit literární rešerši o povodních a jejich 

historii ve studované oblasti a vytvořit fyzicko-geografickou charakteristiku řešeného 

území. Pro fyzicko-geografickou charakteristiku byly zhotoveny a následně popsány 

mapy s různou tématikou o řešeném území. 

Hlavními cíli práce pak bylo stanovit záplavové území na vodním toku Žejdlík, 

na ř. km 0,000 - 14,126. Následně pak hydrotechnicky posoudit objekty nacházející 

se ve zmiňovaném úseku. Pro tento účel byl sestaven hydrodynamický model 

v programu HEC-RAS. Jednalo se o kombinaci 1D/2D modelu, jelikož samotný ID 

model vykazoval v nižších partiích vodního toku značnou nejistotu ve výsledcích. 

Byly tak vytvořeny přehledné mapy záplavového území pro N-leté průtoky Q5, Q20, 

Q100 a Q500. Pro jednotlivé scénáře povodní byly vytipovány problémové lokality 

z pohledu průběhu povodně. 

Na základě výsledků z modelu HEC-RAS pak došlo k posouzení průtočné 

kapacity objektů během různě velkých povodní. Přičemž z výsledků vychází, 

že mnoho objektů na vodním toku je nekapacitních již při malých průtocích. 

Mezi přínosy diplomové práce tak patří pochopení základních příčin vzniku 

povodní na Žejdlíku a také pochopení chování vodního toku během těchto 

hydrologických extrémů. Jelikož se jedná o první vytvořený model na tomto vodním 

toku, tak je bezesporu zásadním přínosem této práce stanovení záplavového území pro 

jednotlivé N-leté průtoky i zmiňované hydrotechnické posouzení objektů. 

Díky tomu může dojít k vypracování určitých protipovodňových opatření. 

Z hlediska možností protipovodňové ochrany je možné na základě diplomové práce 

lokálně uvažovat o individuální ochraně rezidenčních objektů, případně o lokálním 

zkapacitnění vodního toku, a to především v horních částech toků (ř. km 8,500 a výše), 

kde není vhodná morfologie pro větší retenční opatření. Naopak v nižších částech 

vodního toku (ř. km 8,500 a níže), lze uvažovat o možnosti retence vody v nivě formou 

soustavy retenčních průlehů, či suchých nebo víceúčelových nádrží. Pro návrhy 

retence mohou být posouzeny jednak lokality zaniklých rybníků, druhák lokality nové. 

Tyto podklady pak mohou sloužit k vymezení aktivní zóny záplavového území 

či k úpravě a zkapacitnění některých objektů na Žejdlíku. 
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11 Přílohy 

Příloha 1: Hydrotechnické údaje objektů pro N-leté průtoky 
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Příloha 2: Kapacitnost objektů pro různé N-leté scénáře povodní 

Profil Typ objektu Stáni cení (km) Q2fl QIDD Ů50G 

PF_ _5_M ŽLB s in icn í most D, 1515 zahlDenýa pretéwaný zah lcenýa prekeuný zah lcenýa přelévaný z a h l s e r ý a pra+á-srý 
F F_ _8_L D ř e v e n i lávka 0,4129 z a h l c e n ý a přeléwaný zah lcenýa pre léuný zah lcenýa p íe léwný za r a : ; e 4 ' j s r ý 
PF_ _ii_S Kamen ný stu pe ň 0,303 zahlDenýa preJéwaný zah lcenýa pŕekVdný zah lcenýa přelévaný zahlDenýa přeletový 
F F_ _14_M ZLB i i n i m í most zahlcený z a h k e n ý zah lcenýa přeléwný za r a : ! e 4 ' j s r ý 
PF_ _20_M ŽLB mostek 0,945J zahlDenýa přeÉwaný zah lDerýa p ř e É u n ý z.;." -y = cr= •= \a-y zah lcenýa přeiěvarý 
F F_ _3L_M ŽLB s i n k n í most 3003L kapacitní kapacitní zatilceiiý Z = " =̂ " } 
PF_ _15_M ŽLB mostek 34544 zahlceny zahlcený z a t i k e n ý a přeléuný zah lcenýa přelétavý 
F F_ _39_M ŽLB mostek 4,0071 zahlcený zahlcený zati lcený za r ze"'/a přelévaný 

PF_ J H J Dřevěný jez 5,032& z a h l r e n ý a přetékaný zahlDenýa překeuný zah lcenýa přeléuný zah lDerýa p í e l e m ý 
F F_ _50_M ŽLB s in icn í most 5,1015 zahlcený zah lcenýa pre léuný zah lcenýa p f e l é u n ý za r ze 1 -/a přelévaný 

PF_ _52_M ŽLB niDE-tE-k 5,1295I zahlDemya preJéwaný zah lcenýa přelévaný zaň lcenýa přelévaný zah lcenýa píekVový 
F F_ 59L D ŕ e i r e n i lávka 55995 zahlcený zah lcenýa pře léuný zah lcenýa p íe léwný za r a přelévaný 
PF_ _&4_M ŽLB mostek 6,261i kapacitní kapadtni ^acac I-! zah lcenýa přelévaný 
F F_ _&*_L ŽLB lávka 6,353 z a h l c e n ý a pŕeJéuaný zah lcenýa přelévaný zah lcenýa p ř e l e t ný za" De^ýa přelévaly 
PF_ _72_M ŽLB s in icn í most 6,457J zahlcený zahlcený a překeuný zah lcenýa pfe léuný zah lcenýa přelévaný 
F F_ 75 P ŽLB propustek 6,5111 z a h l c e n ý a přeJéwaný zah lcenýa preležaný zah lcenýa pre téuný za" ce^ýa přelévaly 
PF_ 77L Dřevená lávka 6,5457 z a h l r e n ý a pretéwaný zahlDenýa překeuný zah lcenýa pfe láuný zahlDenýa píelávarý 
F F_ _82_M ŽLB mostek 7,1054 z a h l c e n ý a přeléwaný zah lcenýa pře léuný zah lcenýa pre láuný za r ze"'/a přelévaný 

PF_ 90 S Betonový st J peň e , t í i 7 i zah lDenýa pretéwaný zah lcenýa překeuný zaň lcenýa preléuný zah lcenýa přelě-srý 
F F 9L M ŽLB most 8 £ 2 3 3 kapacitní zahlcený zahlcený i =r" =- •} 
P F_97_L Že lezná lávka 8̂ 9204 zahlDenýa preJéwaný zah lcenýa pŕekVdný zah lcenýa p íe léuný zah lcenýa píekVový 
F F_ _U0L_M ŽLB most š,3333 z a h k e n ý a pneÉwaný zah lcenýa pře léuný zahfcenýa pfaJé-jný za - De-ýa z'^á'^ý 
PF_ _10&_M Železný mostek &.D948 zahlDenýa přeÉwaný z a h l c e r ý a p ř e É u n ý z.;." -y = j-=i\3-y zah lcenýa preležaný 
F F_ _1L0_L D ř e v e n i lávka 9,1412 z a h l c e n ý a přeJéwaný zah lcenýa preležaný zah lcenýa pre téuný za - c e - ý a přelévaly 
PF_ _115_M ŽLB s in icn í most 9,2677 kapacitní zahlcený zah lcenýa pfelé«.ný zah lcenýa přelévaný 
F F_ _119_M ŽLB most 9,3432 kapacitní zahlcený zah lcenýa pre léuný za r c e - ý a přelévaný 

F"F_ _1£9_M ŽLB most 9,92&J zahlcený zahlcený zah lcenýa p í e k V m ý 
F F_ _135_M ŽLB most 10,1189 zahlcený zahlcený zahlcený za r ze 1 -/a přelévaný 
F"F_ _141_M Žel e z ni ční m ost 10,5*7 kapacitní kapadtni -:acac I-! kapacitní 
F F_ _144_5 K a m e n n ý stupen 10,4519 z a h l c e n ý a pfeléwaný zah lcenýa pře léuný zah lcenýa pŕeléwný za r a přelévaný 
PF_ _14&_L Ž e l e z o b e t ó n o v á lávka zahlcený zahlDenýa pre íeuný zah lcenýa preléuný zah lcenýa přelévaný 
F F_ _L50_M ŽLB most 10.5556 kapacitní kapacitní zahlcený z • n De ""v 
PF_ _154_M Dřevený můstek 10,6609 zahlDenýa přeÉwaný zah lDerýa překeuný zah lcenýa pfe léuný zah lcenýa přelezený 
F F_ _L5S_M ŽLB s in icn í most 10,4407 kapacitní zahlcený zahlcený za" ce^ýa přelévaly 
F"F_ _1&J_L D řeve no-zel e zná lávka 10,9*03 kapacitní kapadtni zah lcenýa pfe láuný zahlDenýa přelétavý 
F F_ _1&8_L Dřeven o-žel e zni livka 11,0729 z a h l c e n ý a přeJéwaný zah lcenýa pre léuný zah lcenýa p f e l é u n ý za r ze 1 -/a přelévaný 
F"F_ _ĽFJ_L D řeve n o-zel e zná lávka 113-374 kapacitní zah lcenýa pŕekVdný zah lcenýa preléuný zah lcenýa přelěvarý 
F F_ _178_M ŽLB s in icn í most 11,7727 kapacitní zahlcený zah lcenýa preléwný za r a přelévaný 
PF_ _182_L Drevená lávka 11,8097 zahlDenýa pretéuaiý zahlDenýa pre íeuný zah lcenýa preléuný zah lcenýa přelévaný 
F F_ _L83_L Drevená lávka z a h l c e n ý a přelévaný zah lcenýa přelévaný zah lcenýa pfeJáuný za" ce^ýa přelé\aný 

PF_ _189_M 
Že lezo -be tonový most 

12,0647 PF_ _189_M 
5 po t rub ím 

12,0647 
zahlDenýa preJéwaný z a h l c e r ý a přelévaný zah lcenýa preléuný zah lcenýa přelěvarý 

P F_195_M Betonový mostek 12.9208 z a h l c e n ý a pneÉwaný zah lcenýa pře léuný zahfcenýa pfaJé-jný za - De-ýa : ! e 4 ' j s r ý 
P F_202_M ŽLB mostek 13,6230 kapacitní zahlcený z a h k e n ý 
F F_ _204_L ŽLB livka 13,6382 zahlcený zah lcenýa přelévaný zah lcenýa p f e l á u n ý za" ce"ýa přelévaly 
PF_ _20*_M Dřevený morte k 13,6957 zahlDenýa přeeuaný zah lcenýa překeuný zah lcenýa pfelé«.ný zah lcenýa přelévaný 
F F_ _212_L Drevená lávka 13,7382 kapacitní kapacitní zahlcený za - c e - ý a přelévaly 
F"F_ _2L7_M ŽLB mostek 13.S493 z a h k e n ý zahlDenýa překeuný zah lcenýa pfe láuný zahlDenýa píeJevarý 
F F_ _218_M ŽLB mostek 13^614 z a h l c e n ý a přeJéwaný zah lcenýa pře léuný zahfcenýa p í e l é u n ý za r c e - ý a přelévaný 
F"F_ _220_M Ž L B s i n i o i í mostek 13T8972 kapacitní zahlcený zah lcenýa preléuný zah lcenýa přelě-srý 
F F 221 S ŽLB stupen 13.9078 z a h l c e n ý a pŕeé' jarý zah lcenýa pře léuný zař : r - , -ýa cŕa = a-^' za r ce'-ýa c ; e ě , j s r ý j 
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Příloha 3: Mapa záplavového území - část 1 



Příloha 5: Mapa záplavového území - část 3 



Příloha 7: Mapa záplavového území - část 5 



Příloha 9: Mapa záplavového území - část 7 



Příloha 11: Evidenční list objektu PF75P - část 1 

Evidenční list objektu 
Příčný profil PF_75_P ř. km 6,511 ZLB propustek 

Celkový pohled na objekt 

Dno: 200,25 m n. m. Spodní hrana mostovky: 201,29 m n. m. 

Tabulka: 

Přehledná situace 

Horní hrana mostovky: 201,69 m n. m. 

proudění Q1 Q2 Q5 Q10 Q20 Q50 Q100 Q 500 
proudění 

(4,2 m'/s) (6,8 m'ís) (11,0 mVs) (15,0 m'/s) (19,1 m'/s) (26,6 m"/s) (32,8 m'/s) (47,6 m'/s) 

Kóta hladiny horní vody 202,17 202,37 202,50 202,54 202,73 202,86 202,97 203,18 
Kóta hladiny dolní vody 224,83 224,88 224,90 224,91 224,92 224,94 225,00 225,05 

Vliv na proudění zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

Měrná křivka průtoků: 

0 2 4 6 S 10 12 14 16 18 20 22 24 26 28 30 
staničení [m] 

S t r á n k a 1 z 2 
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Příloha 12: Evidenční list objektu PF75P - část 2 

pohled z horni vody na objekt pohled z dolní vody na objekt 

pohled na koryto z (od) objektu po vodě pohled na koryto z (od) objektu proti vodě 

Stránka 2 z 2 
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Příloha 13: Evidenční list objektu PF77L - část 1 

Evidenční list objektu 
Příčný profil PF_77_L ř. km 6,546 Dřevěná lávka 

Celkový pohled na objekt 

Dno: 200,68 m n. m. Spodní hrana mostovky: 201,53 m n. m. 

Tabulka: 

Přehledná situace 

Horní hrana mostovky: 201,71 m n. m. 

proudění Q1 Q2 Q5 Q10 Q20 Q50 Q100 Q500 
proudění 

(4.2 nils) (6,8 rrfls) (11,0 m'/s| (15,0 rrfls) (19,1 mls) (26,6 níVs) (32,8 m'/sl (47,6 m'/s| 

Kóta hladiny horni vody 202,23 202,44 202,80 202,72 202,82 202,96 203,08 203,30 
Kóta hladiny dolní vody 225,86 225,89 225,90 225,91 225,94 225,99 226,20 226,25 

Vliv na prouděni 
zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

Měrná kř ivka průtoků: 

průtok [m3/s] 

204,00 
203,50 
203,00 

] s 10 15 20 25 30 35 40 

Q50  

Q500 
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Příloha 14: Evidenční list objektu PF77L - část 2 

pohled z horní vody na objekt pohled z dolní vody na objekt 

S t r á n k a 2 z 2 

84 



Příloha 15: Evidenční list objektu PFl 78M-část 1 

Evidenční list objektu 
Příčný profil PF J 78 M ř. km 11,773 ŽLB silniční most 

Celkový pohled na objekt 

Dno: 289,33 m n m. Spodní hrana moslovky: 290,80 m n. m. 

Tabulka: 

Přehledná situace 

Horní hrana mostovky: 291,78 m n. m 

proudění Q1 Q2 Q5 Q10 Q20 Q50 Q100 Q500 
proudění 

(3,3 m'/s) (5,3 m'/s) (8,6 m'/s) (11,8 m'/s) (15.0 m'/s) (20,9 m'/s) (25,8 mil) (37.4 m'/s) 

Kóta h ladiny horn í vody 290,07 290,35 290,74 291,08 291,39 291,90 292,05 292,15 
Kóta hladiny dolní vody 291,33 291,54 291,82 292,04 292,52 292,59 292,77 292,80 

Vliv na proudění kapacitní kapacitní kapacitní zahlcený zahlcený 
zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

Měrná křivka průtoků: 

průtok [m3/s] 
20 

44 46 48 50 52 54 

S t r á n k a 1 z 2 
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Příloha 16: Evidenční list objektu PF_178Jví- část 2 

pohled z horní vody na objekt pohled z dolní vody na objekt 

S t r á n k a 2 z 2 
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Příloha 17: Evidenční list objektu PF 195 M - část 1 

Evidenční list objektu 
Př íčný profil PF_195_M ř. km 12,921 Betonový mostek 

Celkový pohled na objekt 

Dno: 327,07 m n. m. Spodní hrana mostovky: 328,11 m n. m. 

Tabulka: 

Přehledná situace 

Horní hrana mostovky: 328,38 m n. m. 

proudění Q1 Q2 Q5 Q10 Q20 Q50 Q100 Q500 proudění 
(2,3 m'/s) (3,7 m'/sl (6,0 m'ls) (8,2 m'/s) (10,3 nt'ls) (14,6 nt'ls) (17,9 m'/B) (26,8 irfls) 

Kóta hladiny horní vody 328,30 328,63 328,67 328,70 328,76 328,83 328,87 328,98 
Kóta hladiny dolnívody 352,75 352,86 352,94 352,98 353,01 353,09 353,12 353,20 

Vliv na proudění zahlcený zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

Měrná kř ivka průtoků: 

průtok [m3/s] 
15 

— e s e 250 Q100 Q500 

8 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40 
staničení [mj 

S t r á n k a 1 z 2 
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Příloha 18: Evidenční list objektu PF 195 M - část 2 

S t r á n k a 2 z 2 
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Příloha 19: Evidenční list objektu PF 220 M— část 1 

Evidenční list objektu 

Příčný profil PF 220 M ř. km 13,897 ŽLB s i ln ičn í mostek 

Celkový pohled na objekt 

Dno: 358,51 m n. m. Spod™ hrana mostovky: 359,74 m n. m. 

Tabulka: 

Přehledná situace 

Horní hrana mostovky: 360,31 m n. m. 

prouděni 
Q1 Q2 Q5 Q10 Q20 Q50 Q100 Q500 

prouděni 
(2,3 m'/s) (3,7 m'/s) (6,0 m Vs) (8,2 m'Js) (10,3 w'lt) (14,5 m'/s) (17,9 ms/s) (25,8 m'/s) 

Kóta hladiny horní vody 359,07 359,25 359,49 359,72 360,08 360,38 360,56 360,70 
Kóta hladiny dolní vody 359,26 359,49 359,80 360,06 360,25 360,40 360,58 360,71 

Vliv na prouděni kapacitní kapacitní kapacitní kapacitní zahlcený 
zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

zahlcený a 
přelévaný 

M ě r n á k ř ivka prů toků: 

prů tok [m3/s] 
15 

S t r á n k a 1 z 2 
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Příloha 20: Evidenční list objektu PF 220 M— část 2 

St ránka 2 z 2 
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